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Introduction-----About SCAS 
 

1. Introduction 
SCAS is an application software to create a SMAF file. 

The created SMAF can be played back by transferring to a mobile phone.  Therefore, it is necessary 

to grasp the LCD screen size (which is called a SMAF effective display area) on a mobile phone where 

SMAF will be displayed beforehand. 

1. The effective display area of a mobile phone is usually about 120 dots x 130 dots.  

2. First, please refer to “Chapter 3 ----- How to Use”. 

 

 
Effective Display Area : about 120dots x 130dots 
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2. About User’s Manual 
This document is User’s Manual for SCAS, which describes SCAS setup methods, basic usage methods, 

and guidelines to create the SMAF contents actually. 

The following table shows you where to find particular information in this manual; 

 

Preparation before use ――― Chapter 1 ----- Preparations before Use  

To know SCAS and SMAF Graphical Content ――― Chapter 2 ----- SCAS and SMAF 

To know basic operating instructions ――― Chapter 3 ----- How to Use  

To know Main Window ――― Chapter 4 ----- Main Window  

To know Graphics Track for editing ――― Chapter 5 ----- Editing Graphics Track  

To know Score Truck editing instruction ――― Chapter 6 ----- Editing the Score Track  

To play back created contents ――― Chapter 7 ----- Emulator Replay  

When you have any trouble ――― Chapter 8 ----- When You Have any Trouble... 

To refer sample data ――― Chapter 9 ----- Samples 
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Chapter 1 -----  Preparations before Use 
 

This section explains the program requirements for SCAS. 

 

1. Operating Environment 
SCAS operates under the following environment; 

 

Correspondent OS Windows®2000, Windows®XP  

CPU Pentium4® 2GB or more or other compatible CPUs 

(Pentium / Celeron 800MHz or more or other compatible CPUs for MA-5 

Emulator) 

Memory 256MB or more 

(64MB or more for MA-5 Emulator) 

HDD 300MB or more free space 

Monitor Resolution XGA (1024x768) or more 

The above CPU specification is recommended for a recent model of a desktop computer.  When you 

are using an old model or a notebook computer, more CPU power may be required. 

 

2. Specifications 
 

Readable Files CAS files for editing (CAS .cas)  

Sound SMAF Files (SMAF .mmf)  

HV-Script Files (HV .hvs)  

XF Files (MIDI .mid with XF corresponding lyrics)  

Text Files (TEXT .txt)  

PNG Files (PNG .png) type, 3 Index Color recommended, 

interlaced PNG unreadable, PNG with an α channel not 

recommended.  

JPEG Files (JPEG .jpg/.jpeg) progressive JPG unreadable.  

Binary (monochrome) Bitmap Files (BMP .bms/.bmp) 

Event CSV Files(.csv) 

Event Information Files(.evt) 

Audio Files(WAVE/AIFF .wav/.aif/.aiff) 

Display Function Terminal Emulator Window 

Edit Function Graphics Track Edit  

Score Track Edit (Only HV and Audio can be edited.) 

Layout Edit 
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Time Edit 

Wipe (Timing for changing characters’ color) Edit 

List Edit 

Check Function Duplication check of text data display 

Playback Function Play 

Pause 

Stop 

Rewind 

Fast-Forward 

Playback Guarantee 

Function 

Amount Surveillance Graph of the memory installed on a 

terminal  

 

3. Install/Uninstall 
On Windows 2000 or Windows XP OS, please install/uninstall the software under the conditions 

described below. 

 

3.1. Install 
Extract a downloaded file so that a new folder (under the same name as the downloaded file) will be 

created.  Double-click the file "setup.exe" to start SCAS Installer.  

Proceed with the installation according to the installer guidance.  

 

3.2. Uninstall 
The software can be uninstalled by the following method;  

 

1. Select [YAMAHA SCAS-MA7-SMAF] from [Add or Remove Programs] in the [Control Panel] in 

order to uninstall the program.  
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4. Folder Information 
  

SCAS Folder The folder in which an application will be installed.  When 

the installation has been done, other designated folders 

are in it (“EN,” “KD,” “SC” folders and so on). 

“EN” Folder The folder in which stores designated setting folders and 

files (“help” and “conf” folders, an SCAS user’s manual file, 

and so on). 

Param Folder Parameter files of the Graphics Track (.par) are saved. 

When a new file is saved for the first time, the application 

automatically creates this folder. 

Conf Folder Terminal Information files (.cfg) are saved.  When 

installation has been done, standard terminal information 

files are in it.. 

 

 

5. Known Problems 
No known problem has been documented so far. 
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Chapter 2 -----  SCAS and SMAF Graphical Content 
 

This section explains the display function of SMAF and the concept of SCAS. 

 

1. SMAF File Structure  
1.1. Introduction 

SMAF is a data format specification which has been mainly built for defining the data expression 

format of multimedia contents for a mobile terminal (mobile phone).  SMAF is an abbreviation of 

Synthetic Music Mobile Application Format.  

 

The data of SMAF specification is expressed in the form which the independent sequence data for 

every output device are bundled in multiple.  It is the data format, expressing that all sequence data 

are synchronized and played accordingly.  Each sequence data here is defined as a play start at a 

time. 

 

The basic part of SMAF is built as the music data expression for our sound source LSI for a mobile 

phone.  Display sequences for texts and graphics are defined as the expanded specification.  By 

combining these functions, it enables you to express the graphic sequence which synchronizes music.  

Therefore, SMAF can be used as a data expression of multimedia contents, which includes KARAOKE. 

 

1.2. File Structure 
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As an output device defined by SMAF specification, there are three kinds of devices: a synthesizer 

device which creates pronunciation by the control data of MIDI, a PCM synthesizer device which plays 

the PCM data, and a display device which displays texts and images.  Within each track the sequence 

data corresponding to the applicable device are stored. 

 

The sequence data are the data expression defined by the control data to the output device in 

time-based.  All sequence data included in one SMAF file are defined as a simultaneous play start at 

time "0".  Therefore, as a result, it is expressed that all sequence data are played and synchronized. 

 

SCAS is an authoring tool in order to create the sequence data to this LCD device.  The formal name 

is called “SMAF Synchronous Contents Authoring System (SCAS).” 

 

2. Editing by SCAS  
 Concept of Editing by SCAS 

 

In SMAF the graphic sequence data, time passing information and LCD control data are lined in the 

chronological order.  This LCD control data is called “Graphic Event.”  Graphic Event is a 

Relative-time from 
Start to Block 

Relative-time from the 
top of Block to Event 
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combination of information about Graphic Objects (such as images or texts to be displayed) and its 

display position and term. 

 

SCAS has the concept of a “Block” as a unit of editing the sequence data.  This editing unit can 

gather multiple graphic events.  A block can be considered the display during contents playback as a 

chunk which is cut off in a certain range of time.  For Graphic Event, a Block is managed from its 

beginning by relative-time.  The time until when the graphic object is actually displayed is the sum of  

the time from the start with the Block sequence and the display time inside the Block.  A Block can 

be relatively moved while keeping the status inside the Block.  Since copying & pasting any Block or 

Graphic Event can be done in SCAS, the similar data can be also created very easily. 

 

In SCAS, first create a Block in to Graphics Track for authoring, and then build an Event in the Block.  

As an edit function, a screen layout function and time edit function are included.  This means that 

the sequence data is edited by separating plane location information from display time information. 

 

 

3. Concept of Plane in SMAF 
 Concept of Plane 

 

SMAF has a concept of three layers of Plane as shown in the above figure. This becomes the 

information which decides a vertical relationship while being drawn on LCD.  

 

Graphic Objects (such as images or texts) hold defined information, on which Plane the object will be 

displayed.  (This information is designated by a user (creator) during authoring.) 
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Plane0 is the plane located in the lower most layers.  Mainly, it is used for the definition of the 

backdrop color; however, any graphic object is not defined. 

Plane2 is the plane located in the upper most layers.  Graphic objects drawn on Plane2 are always 

guaranteed to be displayed over the object on Plane1. This means that the graphic object which has 

a concept close to the background should be always displayed on Plain1 instead of Plain2. 

When multiple objects are located on the same plane at the same time, if overlapped, the one comes 

later will be displayed over the earlier ones. 

 

After being output into the SMAF data, the concept of Block does not exist anymore.  A vertical 

relationship of graphic objects is simply decided by a vertical relationship of planes and a time order 

relationship.  When multiple Blocks are overlapped, it may be difficult to control their vertical 

relationship.  Please keep the structure of Plane and Block as simple as possible. 

 

According to the above descriptions, it is necessary to control the duplication and appearance of 

graphic objects. 
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4. SCAS Coordinate Designation  
 Three Kinds of Coordinate Designation Methods 

 

For SMAF, there are three kinds of coordinate designation methods shown in the above, which are 

prepared to assume a mobile phone LCD size.  The most applicable method can be selected for each 

graphic object location individually.  In addition, coordinate designation methods for X-coordinate 

and Y-coordinate in one graphic object can be also selected individually.  For example, X-coordinate 

is considered as centering by the Layout Coordinate System, whereas Y- coordinate is aligned by the 

Standard Coordinate System. 

In terms oｆ a particular object which you want to use the LCD size in full, it is easier to use the Layout 

Coordinate System. 

 

It is also possible to move the origin of these coordinates.  By designating the origin with the 

Terminal Information dialog so that the original position can be changed in terms of the Standard 
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Coordinate System and the Symmetrical Coordinate System. 

 

* For more details about the coordinate designation and origin move, please refer to “Chapter 5 ----- 

5.7 Coordinate Designation”. 

 

5. Graphic Event and Parameter Designation 

 

5.1. Event Structure 
The Graphic Event data defined by SMAF is built like a figure above.  The Event has its data, its 

coordinate, and its display period for graphic objects.  This Graphic Event can select parameters in 

the range of 0x40 to 0x7F.  Depending on the number, a color set displayed by the defined 

parameter (which can be edited in Graphics Track Information) is used for the interpretation of the 

Event. The Display effect is set to the Event, and then the Event will be displayed by adding its effect 

when interpreting. 

 

5.2. Methods to Use Parameter 
The Graphic Event does not give a meaning implication to the parameter number as a specification 

(Selectable parameter = 0x40 to 0x7f).  

 

For example, it gives a meaning implication on the operation of each parameter (such as lyrics, male 

voice part lyrics, female voice part lyrics, mixture voice part lyrics, a music title, a lyric writer’s name, 

an artist’s name, scripts, interludes, or comments).  After editing these setups in the Track 

Information dialog, the parameter set can be saved and reused later.  
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6. Supplement for Display Effect 
This section explains some effect including banner, fade, and blinking, which are difficult to 

understand to set up.  

 

6.1. Banner Effect 

 

The above is the definition of the Banner effect.  Please change the value in each property, and then 

confirm the operation. 

 

 

6.2. Blink and Color Blink Effect 
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6.3. Fade Effect 

 

These are the types of the Fade effect.  Please switch the type, and then confirm the operation. 
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7. Assumption Specification 
 

7.1. Assumption Spec. of the Terminal of which SMAF is Played 
 

7.1.1. Spec. of Display Device (LCD) 
The LCD size of a mobile phone which the SMAF file can assume is that its effective display area is 

about 120 dots in width and 130 dots in height. 

 

The coordinate of SMAF can be designated by either the standard coordinate system, the symmetrical 

coordinate system, or the layout coordinate system.  

 

The standard coordinate system settles the origin onto the left upper dot of a terminal LCD.  Since 

the symmetrical coordinate system settles the origin onto the right lower dot of a terminal LCD, it is 

affected by the difference of the LCD size.  In the layout coordinate system, regardless of the LCD 

size, designation of "0" shows the left or upper justify, "63" shows the centering, and "127" shows the 

right or lower justify.  By using these coordinate systems for the designation, common contents, 

which reduce the influence of the LCD size, can be created.  

 

[NOTE] For more details about the coordinate designation, please refer to SMAF Coordinate 

Designation  

 

For the color indication, the usage of 256 Direct Color of RGB=3:3:2 is assumed.  Images in SMAF 

contents are displayed by reducing to this RGB data.  

 

 

7.1.2. Font Size 
A font type to be used is a system font in a terminal device.  In order to keep the similarity of the 

contents, some fonts based on the font size of 12dots in width and 13 dots in height should be 

maintained.  In SCAS, the contents are created by using the 12dots x 13dots font size and are 

emulated.  Although, for the strict emulation, it is necessary to use each size of font, each font for 

the terminal device has not been implemented in the present condition.  The adoption size is 

assumed that its width is around 11 to 13 and its character pitch is around 12 to 14. 

Information of the terminals which support the SMAF Graphic System will be updated. 

 

 

7.1.3. Display Rewriting Function 
Assumption display rewriting timing of a mobile phone is about 200 to 300 msec.  It is depending on 

the makers.  Also, this value differs according to load.  This rewriting time may influence a contents 

appearance. 
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Chapter 3 -----  How to Use 
 

The following explains the flow for creating SMAF by using SCAS.  

For more details about SMAF and SCAS, please refer to “Chapter 2 ----- 7 Assumption Spec.” 

 

1. MA-5 or MA-7 ? 
 

Immediately after SCAS gets started, the [Tool Setting] dialog for choosing a targeting spec appears.  

For the selection suitable for the spec of your targeting mobile phone, please refer to our website, 

YAMAHA SMAF GLOBAL (http://smaf-yamaha.com/). 

The emulator with backward compatibility carries “MA-5 Emulator” which can play contents for 

SMAF/MA-3 and SMAF/MA-5, whereas “MA-7 Emulator” which can play contents for SMAF/MA-3, 

SMAF/MA-5, and SMAF/MA-7.  For example, the SMAF which is playable with your mobile phone is 

MA-3, SMAF/MA-3 and SMAF/MA-5 contents can be created whichever you choose “MA-5 Emulator” 

or “MA-7 Emulator”.  However in order to create SMAF/MA-7 contents, you need to choose “MA-7 

Emulator.”  For more details about the difference of operating environment by each emulator, please 

refer to “Chapter 1 ----- 1 Operating Environment”. 

 

2. Create 
If you need any information about “Create,” please refer to “Chapter 8 ----- When You Have any 

Trouble...”. 

 

2.1. Setting Contents Information 
For the specific setup methods, please refer to “2.1 Setting Contents Information”. 

 

2.2. Importing Music Data, Lyrics, and Text Data 
SCAS can import Music data, Sound, Lyrics, and Text Data.  For more information about the 

importing procedure, please refer to “Chapter 4 ----- Main Window”. 

 

2.3. Creating a Block and Placing an Event 
SCAS can create a block and place an event.  By doing so, it enables y you to import images, create 

contents, and edit layouts and timing information.  For more information about creating a block or 

placing an event, please refer to “Chapter 5 ----- Editing Graphics Track”. 

 

2.4. Using Each Edit Function... 
Other than the above, SCAS enables you to edit the SMAF file by using various edit functions.  For 

more information about Edit Functions, please refer to “Chapter 5 ----- Editing Graphics Track”. 
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2.5. While Checking Emulator Playback... 
If you need to check Emulator Playback, please refer to “Chapter 7 -----  Emulator Replay”. 

 

2.6. Generating a SMAF File 
 

 STEP 1 Generate SMAF 
Generate a SMAF file (.miff). 

 

 

 

 STEP 2 Transfer 
Transfer the SMAF data to a mobile phone.  (Transfer through E-mail or an external memory)  

If you need to know any information about [Step 2 Transfer], please refer to “Chapter 8 ----- When 

You Have any Trouble...”. 

 

 

 

 STEP 3 View 
View on a mobile phone. 

If you need to know any information about [Step 3 View], please refer to “Chapter 8 ----- When You 

Have any Trouble...”. 
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Chapter 4 -----  Main Window 
 

1. Appearance of the Main Window 
 

1.1. Pane 
SCAS is roughly divided into three windows and finely divided into five windows.  The upper stage is 

the window for graphic systems: the left side window is Page Edit Window, and the right side window 

is Graphics Track Window.  The middle stage is the window for sound systems: the left side is Score 

Track Information Window, and the right side is Score Track Window.  The lower stage is Amount 

Display Window for Memory Usage. 

 

 

 

Page Edit Pane 
Graphics Track 

Edit Pane

Score Track 
Information Pane 

Score Track 
Edit Pane

Memory Usage Indication Pane
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1.1.1. Page Edit Pane 
In this window, the screen on Graphics Track’s Timebase displayed.  All Events placed on the [E] 

mark line are displayed, and these displayed Events can be edited, and also new Events can be 

created.  In order to move an [E] mark, right-click the mouse on Timebase of Main Window or 

left-click on Graphics Track Window, to the place where you desire to move. 

The solid-line shows an authoring rendering size, whereas the broken-line shows an Output RS Tag 

size.  These can be changed in the Contents Information dialog.  

 

1.1.2. Graphics Track Edit Pane 
In this window, Blocks and Events included in Graphics Track are displayed.  This enables you to 

operate Blocks and Events on Timebase. 

 

1.1.3. Score Track Information Pane 
In this window, Score Track Information is displayed.  The types of Score Track (Score Track / PCM 

Audio Track) and its channel number are displayed. 

 

1.1.4. Score Track Edit Pane 
In this window, the contents of Score Track are displayed.  This enables you to switch Chart Display 

or Pianoroll Display for every channel. 

When Chart Display is displayed, editing of HV or Audio notes can be done.  When authoring of other 

music data is necessary, use an authoring tool for the music data. 

 

1.1.5. Memory Usage Indication Pane 
In this window, the memory amount (memory indicator) which a mobile terminal possibly utilizes is 

displayed.  The types of the indicator and its function are explained below. 

 

Kind Spec. 

Image Development 

Load Memory Indicator 

Since a SMAF player implemented in a mobile phone develops 

compressed pictures simultaneously when playing the data, the 

development process may not be completed when the picture interval 

is too short.  This indicator shows the high loading area.  In the case 

when the development load is markedly too high, the picture 

development may not be caught up, depending on a mobile phone. 

Static Memory Indicator Static Memory Indicator simultaneously monitors whether the picture 

development load implemented in a mobile phone would exceed the 

memory amount which can develop pictures.  Actually, non-displayed 

object may exist when the SMAF display area in LCD becomes larger. 
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1.2. Menu 
1.2.1. [File] Menu 

The following pop-up menu appears when clicking the [File] menu in Main Window.  Selectable 

items will change in each case.  

 

 

New 

Creates a new data. 

Open... 

Opens an existing file.  The applicable file is a CAS file. 

Save 

Saves the data into the current file.  

Save As... 

Saves the current editing data under a new name. 

Save for SCAS-MA2-SMAF... 

Saves the current editing data under SCAS-MA2-SMAF file 

type. 

Its music data will be deleted. 

SMAF File... 

Generates a SMAF file with the current editing data. 

Import 

Displays a submenu to show the importable files’ list.  

Export 

Displays a submenu to show the exportable files’ list. 

CAS File Info... 

Displays a CAS File version.  

Version1 :before SCAS MA-2 ver1.80 or MA-3 ver3.04  

Version2 :after SCAS MA-2 vre1.81 or MA-3 ver3.05  

Vresion3 :after SCAS MA-2 ver2.01, MA-3 ver3.20, or MA-5 

ver4.01  

Version4 :after SCAS MA-5 ver5.10  

Version6 :after SCAS MA-5 ver6.02 

Version7 : after SCAS-MA7-SMAF ver.6.03 

Version8 : after SCAS-MA7-SMAF ver.7.0.0 

Version9 : after SCAS-MA7-SMAF ver.7.3.0 

Document 

Displays the file names which have been used recently.  

Opens the designated CAS file. 

Exit... 

Exit the SCAS application. 



 24

 

 

1.2.2. [Edit] Menu 
The following pop-up menu appears when clicking the [Edit] menu in Main Window.  Selectable 

items will change in each case. 

 

 

Undo 

Undo function.  It initializes the operation history such as 

creating a new file, importing a file, or deleting an image.

Redo 

Re-do function.  It will redo the latest operation which is 

undone.  It can be used only once by each time.  Use 

this function when "undo" was over-done. 

Cut 

Cuts the selected object/area and copy to the clip board. 

Copy 

Copies the selected object/area to the clipboard. 

Paste 

Pastes the clipboard contents to the insert position.  It is 

also possible to copy or paste graphic events on Page Edit 

Window. 

Delete 

Deletes the selected object/area. 

Select All 

Selects all items such as Blocks in Graphics Track Window 

or Events in Page Edit Window. 

Paste Text 

Pastes the text data from the clipboard.  It is possible to 

copy and paste the Display Event on Page Edit Display. 

Paste Special 

Ａｐｐｏｉｎｔs a form and pastes the clipboard data.  [Block 

paste], [Block paste with image and bitmap], or [Color 

Attribute Paste] of the Event can be performed. 

Contents Info... 

Edits the contents information. For more details about 

editing the contents information, please refer to “Chapter 3 

----- 2.1 Setting Contents Information”. 

Graphics Track Information... 

Refers and changes Graphics Track information.  For more 

details about changing graphics track information, please 

refer to “3.1.4 Setting Graphics Track Information”. 
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Play Information... 

Adjusts Play information from the Play Information Setting 

dialog.  Its Peak Gain value, Start Time Delay, Playback 

beginning time, LED and Vib On/Off are adjusted here.  

For the procedure to set up playback information, please 

refer to “Chapter 6 ----- 1 Play Information Dialog”. 

Mixer... 

Shows a Mixer dialog.  Adjusts volumes and effects for 

each channel.  For more details, please refer to “Chapter 

6 ----- 2Mixer Dialog”. 

Create Block 

Creates a new Block.  A “Block” means a unit to edit 

Graphics Track.  For more details about creating a block, 

please refer to “Chapter 5 ----- 1.2.1 Creating a Block”. 

Edit Block... 

Edits the selected Block.  Displays the Block Edit dialog of 

selected Block.  When multiple Blocks are selected, the 

Block at the most left-hand side will be applicable.  For 

more details about editing a block, please refer to “Chapter 

5 ----- 2 Editing in the Block Edit Window”. 

Change Block Name... 

Changeｓ a name of the selected Block.  Displays the 

Change Block Name dialog for the selected Block.  When 

multiple Blocks are selected, the one at the most left-hand 

side will be applicable at first, and then others also can be 

changed continuously. 

Delete Block 

Deletes the selected Block.  When multiple Blocks are 

selected, all Blocks are deleted. 

Background Color 

Adds, modifies, or deletes Backdrop Color. 

Merge Blocks... 

Merge the selected block with other block.  Displays the 

Block Merge dialog for the selected Block.  Select a Block 

to be merged, and then these will be merged into one 

Block. 

Split Block... 

Split the selected block and create tow new blocks. 

Displays the Block Split dialog for the selected Block.  It is 

available only when multiple Blocks exist. 
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1.2.3. [Tool] Menu 
The following pop-up menu appears when clicking the [Tool] menu in Main Window.  Selectable 

items will change in each case. 

 

 

 

Wipe Edit.. 

Edits wipe sequence time of graphics track including Text Event 

and Text Block Event collectively.  For more details about 

editing wipe time, please refer to “Chapter 5 ----- 5.1 Wipe 

Edit”. 

Graphics Track List Edit... 

Edits graphics track list.  Displays the Graphics Track list Edit 

dialog which shows attributes of Graphics Events in the 

contents in a list form.  All attributes can be edited.  For more 

details about Graphics Track List Edit, please refer to “Chapter 5 

----- 5.3 Graphics Track List Edit”. 

List Edit... 

Edits graphics event list.  Displays the List Edit dialog, which 

shows Graphics Events in the contents in a list form.  Any 

timing information can be edited.  For more details about List 

Edit, please refer to “Chapter 5 ----- 5.2 List Edit”. 

Block List... 

Displays the Block List dialog which shows all pages (Blocks) in 

the contents.  When the displayed page is displayed, the Block 

Edit dialog of the page appears directly.  For more details 

about Block List, please refer to “Chapter 5 ----- 5.5 Block List”.

Duplication Check... 

Checks duplication of the text data in Graphics Track.  Any 

overlapped Events at the same time are considered to be a 

duplication.  Text Event and Text Block Event are applicable. 

For more details about Duplication Check, please refer to 

“Chapter 5 ----- 5.4 Duplication Check”. 

Object Registration... 

Opens the Object Registration dialog.  Images and 

monochrome bitmaps which need to be displayed in the 

creating content can be registered.  The objects to be 

registered are PNGs, JPEGs, and bitmaps (Binary Windows 

Bitmap).  For more details about Object Registration, please 

refer to “Chapter 5 ----- 4.1 Object Registration”. 

HV Registration... 



 27

Opens the HV Registration dialog.  HV-Scripts which need to 

be used in the creating content can be registered.  For more 

details about HV Registration, please refer to “Chapter 6 ----- 

4.1 HV Registration”. 

Audio Registration... 

Opens the Audio Registration dialog.  Audio files which need to 

be used in the creating content can be registered.  For more 

details about Audio Registration, please refer to “Chapter 6 ----- 

4.2 Audio Registration”. 

Delete Play Information... 

Deletes sound system tracks (play tracks) except for Graphics 

Track. 

 

1.2.4. [Event] Menu 
 

When Page Edit Window is selected, the [Event] menu is displayed.  The following pop-up menu 

appears when clicking the [Event] menu in Main Window.  Selectable items will change in each case. 

 

 

Save... 

Saves the selected Events into the Event file or the CSV file (*.evt 

or *.csv).  An Event from the open CAS file can be extracted by 

selecting the event type. 

Load... 

Loads events from the Event file or the CSV file (*.evt or *.csv) to 

the selected Blocks or Evens.  A new Block can be created as well.

New 

Creates a new Event.  Select [Text…], [Text Block…], [Bitmap 

Text…], [Image…], [Image Tile…], [Bitmap…], [Bitmap Tile…], 

[Rectangle], [HV], or [Audio] from the sub-menu. 

Attribute... 

Changes an Event attribute.  Opens the Text Event dialog for the 

selected Event. 

Move Sequence... 

Adds or modifies the Move Sequence, or makes the move 

sequence synchronized with dragging. 

Split Text... 

Opens the Text Split dialog.  And then set a cursor at the position 

to be split. 

Merge Text... 
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Opens the Text Merge dialog. 

Auto Layout... 

Locates designated Text Events by selecting a particular layout 

style. 

Align Left 

Aligns the selected Event to the left. 

Centering 

Aligns the selected Event to the center. 

Align Right 

Aligns the selected Event to the right. 

 

1.2.5. [Emulator] Menu 
 

The following pop-up menu appears when clicking the [Emulator] menu in Main Window.  Selectable 

items will change in each case. 

 

 

Play 

Starts replaying the editing data in the Emulator window.  

Pause 

Pauses the playing data in Emulator.  

Stop 

Stops the playing data in Emulator.  

Forward 

Fast-forwards the Replay Start position for one second.  

Rewind 

Rewind the Replay Start position for one second.  

Forward 100ms 

Fast-forwards the Replay Start position for 0.1 second.  

* Not available in Time Signature Display  

Rewind 100ms 

Rewind the Replay Start position for 0.1 second. 

* Not available in Time Signature Display. 

Terminal Information... 

Sets up the information of a mobile phone which is assumed by its 

contents.  The information can be stored in a file.  The saved 

terminal information is listed in [Emulator] menu (in a drop-down 

list) and can be opened directly by selecting the desired 

information as a designated Emulator Window.  For more details 

about Terminal Information, please refer to “Chapter 7 ----- 1 
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Setting Terminal Information”. 

Emulator List 

Lists the registered terminal information.  

Emulator Window can be opened directly by selecting a 

designated item of the terminal information.  The screen size of 

Emulator Window can be enlarged up to 4 times. 

Emulator Window... 

Displays the registered terminal information in the Emulator 

Window dialog.  A selected Emulator Window in the list will be 

opened.  The screen size can be enlarged up to 4 times. 

MIDI Time Code... 

Sets up whether MIDI Time Code should be output during 

Emulator replay. 

 

1.2.6. [View] Menu 
 

The following pop-up menu appears when clicking the [View] menu in Main Window.  Selectable 

items will change in each case. 

 

 

Display Timebase 

Switches a Timebase display in Graphics Track Window and Score 

Track Window.  Select either [Time Signature Display] or [Actual 

Time Display] from the submenu.  

Designation Quantize... 

Displays the Quantize Setting dialog.  Actual time display and 

Time signature display can be modified.   

Display Channel 

Switches the channel display type in Score Track Window.  Select 

either [Pianoroll Display] or [Chart Display] from the submenu.  

Magnification 

Changes the magnification of Page Edit Window.  Select either 

[x1], [x2], [x3] or [x4] form the sub menu.  

Rendering Size Guideline (File output RS tag line) 

Displays/un-displays the broken-line frame which shows the 

rendering size in Page Edit Window.  

Origin Designation Guideline 

Displays/un-displays a solid-lined frame which shows the Origin 

Designation Guideline in the Page Edit Window. 

Plane 
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Displays/un-displays the Event edit on designated Plane. 

[Plane1], [Plane2], and [Plane3] are selected in the sub menu.  

Tool Bar 

Displays/un-displays the designated tool bar(s).  Each tool bar 

can be selected from the submenu.  For more details about 

Sub-Menu, please refer to “1.2.6.1 Tool Bar”. 

Status Bar 

Displays/un-displays Status Bar which is shown in the lower part of 

Main Window.  

Split 

Changes the Main Window’s split position.  

Indicator 

Displays/un-displays Image Development Load Indicator and Static 

Memory Indicator which are shown in the left-lower part of Main 

Window.  These indicators can be also grouped. 

Zoom In 

Expands the scale of Timebase.  It is used for making the short 

time-base display larger.  

Zoom Out 

Reduces the scale of Timebase.  It is used for making the longer 

time-base display smaller. 
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1.2.6.1. Tool Bar 
 

 

Tool Bar 

Switches the display of the tool bar for operating files.  It consists of 

New, Open, Save, Generate SMAF File, Cut, Copy, Paste, Graphics 

Track List Edit, Register Object, Contents Information buttons.  It 

can be also used as a floating tool bar.  

Edit Bar 

Switches the display of the tool bar for editing Blocks.  It consists of 

Create Block and Delete Block Delete buttons.  It can be also used as 

a floating tool bar.  

Zoom Bar 

Switches the display of the tool bar for zooming Timebase.  It 

consists of Zoom In and Zoom Out buttons.  It can be also used as a 

floating tool bar.  

Play Bar 

Switches the display of the tool bar for operating the emulator.  It 

consists of Time display, Rewind, Rewind (100ms), Play, Pause, Stop, 

Fast-Forward (100ms), and Fast-Forward buttons.  It can be also 

used as a floating tool bar.  

Emulator Bar 

Switches the display of the tool bar for operating Emulator Window. 

It consists of Emulator Window and Open And Close Emulator buttons. 

It can be also used as a floating tool “bar”.  

Volume Bar 

Switches the display of Volume Slider.  It can be also used as a 

floating tool bar.  

Object Edit Bar 

Switches the display of tool bar for operating Event Edit. It consists of 

Text, Text Block, Bitmap Text, Image, Image Tile, Monochrome 

Bitmap, Monochrome Bitmap Tile, Rectangle, HV Note, Audio Note, 

Attribute, Split Text, Merge Text, and Delete Event buttons.  It can be 

also used as a floating tool bar.  

Page Zoom Bar 

Switches the display of the tool bar for switching the display 

magnification.  It consists of x1, x2, x3, and x4 buttons.  It can be 

also used as a floating tool bar.  

Page Layout Bar 

Switches the display of the tool bar for Event layout.  It consists of 
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Align Left, Centering, Align Right, and Auto Layout buttons.  It can be 

also used as a floating tool bar.  

Plane Bar 

Switches the display of the tool bar for designating Plane.  It consists 

of Plane0, Plane1, and Plane2 buttons.  It can be also used as a 

floating tool bar. 

Play Information Bar 

Switches the display of the tool bar for Play Information.  It consists 

of Play Information Setting and Mixer Information buttons.  It can be 

also used as a floating tool bar. 

Quantize Bar 

Consists of the button to display the value set in the Quantize 

Selection dialog and the checkbox to execute ON/OFF Quantize 

Selection.  It can be used as a floating tool bar. 
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1.2.7. Right-Click on the Main Window 
When right-clicking on SCAS Main Window, a pop-up menu appears.  Menu items differ depending 

on each pane on Main Window.  Selectable items will change according to each condition. 

 

 

 

1.2.7.1. Page Edit Pane 
 

 

New 

Creates a new Event.  Select a desired type of Event from the submenu.

Attribute...  

Opens the Setup dialog for selected Event whose attribute is changed.  

Move Sequence 

Adds and corrects Move Sequence or make Move Sequence synchronized 

with dragging. 

Split Text...  

Page Edit Pane 
Graphics Track 

Edit Pane

Score Track 
Information 

Score Track 
Edit Pane

Memory Usage Indication Pane
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Opens the Text Split dialog to split a Text Event into two Text Events.  

Merge Text...  

Opens the Text Merge dialog to merge two Text Events into a Text Event. 

Align Left  

Aligns the selected Event to the left.  

Centering 

Aligns the selected Event to the center.  

Align Right  

Aligns the selected Event to the right. 

 

 

1.2.7.2. Graphics Track Edit Pane 
 

 

Graphics Track Information... 

Opens the Graphics Track Information dialog to edit the 

management information.  

Create Block  

Creates a new Block.  A “Block” means an edit unit for 

Graphics Track. 

Edit Block... 

Edits the selected Block.  Displays the Block Edit dialog of 

selected Block.  Layout and timing can be edited.  

Change Block Name...  

Changes a name of the selected Block.  Displays the Change 

Block Name dialog for the selected Block. 

Delete Block  

Deletes a selected Block.  

Backdrop Color  

Adds, modifies, or deletes Backdrop Color. 

Wipe Edit...  

Edits Wipe sequence time of Graphics Track including Text 

Event and Text Block Event collectively. 

Graphics Track List Edit...  

Displays a list of information of all Blocks and Events that are 

contained in the contents.  All attributes and effects that are 

contained in the Events can be edited.  

List Edit...  

Displays a list of all Events that are included in the contents. 

Display Time and Lifetime can be edited. 
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Block List...  

Displays the Block List window which shows all pages (Blocks) 

in the contents.  When clicking the displayed page (Block), the 

Block Edit window of its page (Block) appears directly.  

Duplication Check...  

Checks any overlap of the text data in the Graphics Track.  Any 

overlapped Events at the same time are considered to be 

duplication.  Text Event and Text Block Event are applicable.  

Object Registration... 

Opens the Object Registration dialog.  Images and 

monochrome bitmaps which need to be displayed in the 

creating content can be registered.  The objects to be 

registered are JPEGs, PNGs, and Bitmaps (Binary Windows 

Bitmaps). 

Import  

Displays importable files (XF file and Text File) in the submenu.

Export  

Displays an exportable file (Text File) in the submenu. 

Display Time Base  

Switches a Timebase display in the Graphics Track Window and 

the Score Track Window.  Select either [Time Signature 

Display] or [Actual Time Display] from the submenu. 

Zoom In  

Increases the scale of Timebase.  It is used for making the 

short time-base display larger. 

Zoom Out  

Reduces the scale of Timebase.  It is used for making the 

longer time-base display smaller. 
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1.2.7.3. Score Track Information Pane 
 

 

 

 

Display Channel 

Switches the channel display type in Score Track Window.  Select 

either one of [Pianoroll Display] or [Chart Display] from the submenu.

Play Information... 

Adjusts Play Information from the Play Information Setting dialog.  

Peak Gain value, Start Time Delay, Playback beginning time, LED and 

Vib On/Off are adjusted here.  For the procedure to set up the 

playback information, please refer to “Chapter 6 ----- 1 Play 

Information Dialog” 

New 

Creates a new Event.  Select an Event type (HV or Audio) to be 

inserted.  

HV-Script Registration... 

Opens the HV Registration dialog.  HV-Script which needs to be 

created in the contents can be registered.  For more information 

about HV Registration, please refer to “Chapter 6 ----- 4.1 HV 

Registration”. 

Audio Registration... 

Opens the Audio Registration dialog.  The Audio file which needs to 

be created in the contents can be registered.  For more information 

about Audio Registration, please refer to “Chapter 6 ----- 4.2 Audio 

Registration”. 

Import  

Displays a submenu to show (an) importable file list(s).  

Delete Play Information... 

Deletes sound system tracks except for Graphics Track. 
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1.2.7.4. Score Track Edit Pane 
 

 

 

Cut 

Cuts the selected object and pastes it on to the clip board. 

Copy 

Copies the selected object and pastes it on to the clip board. 

Paste 

Pastes the contents stored in the clip board in to the desired 

area.  It is also possible to copy or paste graphic events on the 

Page Edit Window. 

Display Channel 

Switches a channel display in the Score Track Window.  Select 

either [Pianoroll Display] or [Chart Display] from the sub menu. 

Play Information... 

Adjusts the PeakGain value, playback beginning time, and LED 

and Vib On/Off status.  For a procedure to set up playback 

information, please refer to “Chapter 6 ----- 1 Play Information 

Dialog”. 

New 

Creates a new Event.  Select the type of Event (HV or Audio) 

to create from the submenu.  

HV Registration... 

Opens HV Registration dialog.  The HV-Script which needs in 

the creating contents can be registered.  For more information 

about HV Registration, please refer to “Chapter 6 ----- 4.1 HV 

Registration”. 

Audio Registration... 

Opens the Audio Registration dialog.  The Audio file which 

needs in the creating content can be registered.  For more 

information about Audio Registration, please refer to “Chapter 

6 ----- 4.2 Audio Registration”. 

Import 

Displays a submenu to show (an) importable file list(s).  

Display Timebase 

Switches Timebase display both in the Graphics Track Window 

and the Score Track Window.  Select either [Time Signature 

Display] or [Actual Time Display] from its sub menu.  

Zoom In 

Increases the scale on Timebase.  
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Zoom Out 

Reduces the scale on Timebase. 

Delete Play Information... 

Deletes sound system tracks except for Graphics Track. 

 

1.2.7.5. Memory Indicator Pane 
 

Switches in display/undisplay of Static Memory Indicator and 

Image Development Load Indicator. 

 

 

1.3. Tool Bar 
As a default, there are 12 Tool Bars on the upper part of the Main Window, such as Tool Bar, Edit Bar, 

Zoom Bar, Play Bar, Emulator Bar, Volume Bar, Object Edit Bar, Page Zoom Bar, Page Layout Bar, Plane 

Bar, Play Information Bar, and Quantize Selection Bar.  Each bar has the particular buttons which are 

related respectively to filing, editing, zooming the Graphics Track Window, replaying the emulator, 

changing the emulator, adjusting the volume, modifying Events, zooming the Page Edit Window, 

making Event layout, switching Planes, editing Play Information, and selecting Quantization.  

Clicking these buttons has the same effect as selecting the item from the menu.  Each tool bar is a 

floating tool bar; therefore, it can be displayed separately from the Main Window.  In addition, it can 

be switched between display and un-display individually by selecting each item from the [View] menu.  

These work in toggle operation. 

 

 

1.4. Status Bar 
The Status Bar, which is for displaying information, is located at the lower part of the Main Window.  

On the left side of the Status Bar, the information about each corresponding menu is displayed.  On 

the right side, the information about the elected Block or Event is displayed.  The Status Bar can be 

displayed or un-displayed by selecting [Status Bar] from the [View] menu. 
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2. Operation in the Main Window 
 

2.1. Starting and Exiting 
In order to start SCAS, double-click the SCAS icon, or select [YAMAHA]  [SCAS]  

[SCAS-MA7-SMAF] from the Start menu. 

 

In order to exit SCAS, click the [close] button on the right top corner of the Main Window just like 

other applications, or select [File]  [Exit] from the menu in the Main Window. 

 

2.2. Creating a New Data File 
Just after the SCAS has been started, the window is ready to create a new data file.  When needed 

creating a new data file while editing other data, select [File]  [New] from the menu, or click the 

[New] button on the Tool Bar.  When the existing data file has been changed, a confirmation dialog 

appears and asks whether the existing data file needs to be saved.  Click [Yes] if it does. 

 

2.3. Opening an Existing Data File 
In order to open an existing CAS file (*.cas), which has been already edited and saved, select [File]  

[Open] from the menu.  Select a file to be opened when the Open file dialog appears, then click 

[Open].  When the file is opened without any problem, its file name will be indicated on the Title Bar, 

and its contents will be displayed in the window.  The same procedure is achieved when the CAS file 

is dragged and dropped on to the Main Window. 

 

 

2.4. Saving a Data File 
When a new data file has been created, the data is named as "Untitled" initially.  This is also 

indicated on the Title Bar.  Save the data file by selecting [Save] or [Save As] from the [File] menu, 

or click the [Save] button on the Tool Bar.  Furthermore, for saving the data in a format importable to 

SCAS-MA2-SMAF, select [Save for SCAS-MA2-SMAF] from the [File] menu.  Normally, the new data 

file will be replaced by its existing named file when [Save As] is selected.  In this case, this file is 

over-written.  But in the case of which the file name is "Untitled", the “Save As” dialog opens.  

Name the file, and then the file name will be indicated on the Title Bar.  If selecting [Save As], the 

“Save As” dialog also opens.  Name the file, and then the file name will be indicated on the Title Bar.  

When selecting [Save for SCAS-MA2-SMAF], any play information is deleted.  When executing [Save] 

after performing [Save for SCAS-MA2-SMAF], the data will be saved under the SCAS-MA7-SMAF 

specialized format. 
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2.5. Generating a SMAF File 
Select [File]  [SMAF File] from the menu to generate a SMAF file. 

When the "Generate SMAF File" dialog opens, enter the SMAF file name and click [OK]. 

 
 

2.5.1. Terminal 
Select a terminal type (MA-3, MA-5 or MA-7) of the SMAF format by pressing the radio button.  If 

music data does not exist, or music data is in an MA-3 format, MA-3 is automatically selected.  If 

music data is in an MA-5 format, MA-5 is automatically selected.  If music data is in an MA-7 format, 

MA-7 is then automatically selected. 

 

2.5.2. Output File 
Sets up a SMAF file name.  Click the [>>] button to select an output file directory. 

 

2.5.3. Message 
When selecting the radio button, the contents definition is checked whether the SMAF file can be 

generated correctly.  And then its result message will be displayed here. 

 

When there is any problem with the contents definition, a warning sign will be displayed.  The SMAF 

can not be generated.  Fix the contents definition if needed.  

• Whether any data is in Graphics Track.  (Note: This is not applied to the SCAS-MX-SMAF.)  

• Whether the SMAF definition is suitable for the applicable terminal.  

• Whether drawing processing load by the specific banner definition is within the standard 

range. 

• Whether the total number of images, bitmaps, and bitmap texts that have been registered 

into the SMAF is less than 50.  (When the applicable terminal is MA-7, the total number 
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NOTE!!

should be less than 128.)  

• When the contents definition is suitable, two messages may be displayed.  

• Whether font size designation of the Event exists.  

• Whether the size of the SMAF file after generating process will be within the applicable size. 

 

 Any data that SCAS has output to the SMAF can not be edited.  It is necessary to save 

any CAS file (*.cas) in the case of re-editing.  (the CAS file is a special file format for 

re-editing.) 

 

 

2.6. Displaying Timebase and Zoom Timebase 
 

2.6.1. Displaying Timebase 
The horizontal axis of the Graphics Track Window and the Score Track Window is a Timebase.  There 

are two types of display: [Time Signature Display] and [Actual Time Display].  Select [Display 

Timebase] from the [View] menu to switch the type of display. 

 

2.6.2. Zooming Timebase 
The scale width of the Timebase in the Graphics Track Window and the Score Track Window can be 

changed.  Select [Zoom In] or [Zoom Out] from the [View] menu to change the scale width.  In 

addition, the [+] and [-] buttons on the Zoom Bar have the same effect respectively.  While holding 

the button pressed, it changes continuously. 

 

2.6.3. Changing Display Magnification 
The display magnification of the Page Edit Window can be changed.  In order to change the size of 

the terminal screen, select [View]  [Magnification], or click the [x1], [x2], [x3] or [x4] button on the 

Page Zoom Bar. 

 

2.7. Dividing Window 
The Main Window is divided into the Page Edit Window, the Graphics Track Window, the Score Track 

Information Window, and the Score Track Window.  Each window size can be adjusted by holding 

and dragging the dividing bar of the center window.  In addition, when selecting [Split] from the 

[View] menu, the mouse cursor is moved on the center of dividing bar automatically.  Dividing the 

window can be done by dragging the mouse cursor or using the direction keys on the keyboard.  

Press the Enter key to finalize the movement. 

 

 

2.8. Displaying Program Information 
When selecting [About SCAS] from the [Help] menu, the “About SCAS” dialog appears, showing the 

copyright information of the software and the version information of SCAS.  When selecting [Help] 
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from the [Help] menu, this help manual is displayed.  When selecting [Yamaha SMAF GLOBAL] from 

the [Help] menu, a link site to YAMAHA SMAF GOLABL (http://smaaf-yamaha.com/) us displayed. 

 

2.9. I/O Data 
In the SCAS, a data file can be imported in order to utilize the existing data effectively.  A word, 

“import”, means to “load” an entire or a part of the existing data by converting into an SCAS internal 

form. 

 

2.9.1. Importing music data 
A music part of synchronized contents is imported.  The SMAF file created by the Sound System 

Authoring Tool can be imported.  For more details about importing music data, please refer to “3.2.1 

Importing Music Data”. 

 

2.9.2. Importing lyric data 
A lyric part of synchronized contents is imported.  Both the XF file and text file can be imported.  

For more details about importing lyric data, please refer to “3.1.1 Importing Lyric Data”. 

 

2.9.3. Exporting a TEXT file 
All the text in Text Event and Text Block Event included in the contents are exported into the text file.  

The text in one Event is exported as in one line.  One line-feed is inserted between Blocks.  For 

more details about importing text files, please refer to “3.1.3 Importing TEXT File”. 

 

http://smaaf-yamaha.com/
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3. Graphics Track and Score Track 
 

3.1. Graphics Track 
Graphics Track, as a direct target to be edited by SCAS, is created.  There are two ways to create it; 

selecting [New] from the [File] menu on the Main Window and importing text data to create 

automatically.  However, the number of Graphics Track which can be made is one. 

Various information about editing in Graphics Track can be set up. 

 

 

3.1.1. Importing Lyric Data 
 

The lyric part of synchronized contents is imported.  The XF file or text file can be imported.  Select 

[Import] from the [File] menu on the Main Window to import the data.  Then click a type of the data 

file to be imported from the submenu.  Select a data file to be imported as a lyric data from the 

“Open” dialog.  Now, the “Import Text file” dialog appears.  Click [OK] to import the lyric data into 

Graphics Track. 
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When the import process has been completed properly, a block and text event created automatically 

will be displayed in Graphics Track Window.  The backdrop color of the parameter type "0x00" is 

reflected on the background color of the block.  If any error occurs, the importing process will be 

cancelled with displaying the cause.  If any data has already been existed in Graphics Track, all 

existing data will be cleared, and a new imported data will be replaced.  

When any music data has been existed in Score Track, Score Track can be cleared by choosing 

“Delete Play Information” from the [Tool] menu. 

 

Display position, Display time, Wipe time, and Life time of the text event are automatically set up. 

Please edit these by using Wipe Edit. 

 

 

3.1.2. Importing an XF file 
 

Extract and import a lyric data from the XF file (*.mid) used by such as KARAKU.  

 

3.1.3. Importing a Text file 
 

The text data included in Text file (*.txt) is imported. 

One line of the text data becomes one Text Event.  A long string will be divided into pieces with the 

maximum of 128bytes.  When linefeed is performed twice in a row in this imported text, it is 

considered to be the end of a page (block) by SCAS, and a new block will be created separately.  The 

Text Event is created with the color attribute and the coordinate system of the parameter type "0x40" 

when the text file is imported.  

It is useful if the parameter setting is done in the Graphics Track Information dialog beforehand. 
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3.1.4. Setting Graphics Track Information 
 

SCAS allows you to set up the information about the Graphics Track to be created.  Setting of the 

color or parameter can be saved into a file and reused later.  Select the Graphics Track pane, then 

click [Graphics Track Information...] from the [Edit] menu to display the Graphics Track Information 

dialog. 

 

 

 Property of Graphics Track Information Dialog 

Format Type It cannot be changed from the default setting.  This SCAS 

corresponds only to the HandyPhoneStandard format.  

Player Type It cannot be changed from the default setting.  This SCAS 

corresponds only to a mobile phone.  

Character Code It cannot be changed from the default setting.  The character code 

only for the Carrier is set up.  

Color Type It cannot be changed from the default setting.  This SCAS 

corresponds only to the StandardColor.  
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Timebase It sets up the minimum decomposition capability of Event time.  The 

decomposition capability of the synchronized playback on a mobile 

phone is assumed to be around 100msec.  This value only changes 

the accuracy of setup for the timebase interval of an Event.  

Parameter An Event has its parameter type; therefore, it can have the particular 

graphic parameter.  The display color can be set for each of these 

types.  (For example, the color setting for the light-ground-color or 

dark-ground-color can be set up, and also the color setting is used to 

separate each parameter to its destination. 

Save of parameter The changed parameter setting can be saved.  Click [Save] in the 

Graphics Track Information dialog to open the “Save As” dialog. 

Designate the name of the file and click [Save].  The parameter will 

be saved into a file type (*.par).  

Load of parameter The parameter setting which has been saved into a file (*.par) can be 

loaded.  Click the [Load] button on the Graphics Track Information 

dialog to open the “Open” dialog.  Select a file and click [Open].  The 

parameter will be loaded.  At this time, the existing parameter data is 

cleared. 
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3.1.4.1. Setting Event Parameters 
In SCAS, a graphic parameter for an Event can be set up.  Mainly, setting can be done by combining 

multiple color attributes or coordinate systems and stored.  By using these multiple Event types, 

color setting can be performed easier when creating an Event.  In addition, when modifying the 

color in multiple times or using the wipe function repeatedly, the data size can be also economized. 

Select and click a parameter on the parameter list or click the [Change] button in the Graphics Track 

Information dialog, so that the “Change Parameter” dialog appears. 

 

 

 Setting Property of Parameter Change Dialog 

Parameter name The arbitrary name can be set up. 

Parameter type The parameter type which has been selected for editing is displayed. 

This becomes a parameter identifier at the time of setting an Event. 

Font The text font style used in the Graphics Track is selected.  It can not 

be changed at present.  

Font size The text font size is designated.  It is fixed to "12" and can not be 

changed.  

Display direction The display direction of the text is selected.  It is fixed to "Horizontal", 

and can not be changed.  

Attribute The display attribute of the text is selected.  It is fixed to "Normal”, 

and can not be changed.  

Coordinate system The coordinate system of an object display position is designated.  
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Text color Text color, Background color, Text color after wipe, and Background 

color after wipe for the text or the 2-value-bitmap data are set up. 

Edge color and Edge color after wipe can not be changed.  

Backdrop color The Backdrop color of the contents is set up.  Any parameter for the 

parameter type "0x00" can only be set up.  The Backdrop color set 

here is reflected on as a default Backdrop color of the Graphics Track. 

Transparent process The setting whether to use the transparent process in the object 

display and the transparent color are set up.  SMAF displays a 

multi-colored image data in the reduction color into RGB=3:2:2.  

When using the transparent process, it is necessary to match the 

reduction color to the value of transparent color designation. 
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3.2. Score Track 
 

In SCAS, the Score Track can be created by importing a music data or a compressed audio file.  It 

also can be done so by creating an HV-Script or Audio data as events.  Music data formats that can 

be registered are as follows; 

 

Data that can be imported Format Maximum Amount 

SMAF SMAF/MA-1,MA-2,MA-3,MA-5,MA-7 1 

HV HV-Script 64 

Audio Wave, AIFF 32 
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3.2.1. Importing Music Data 
 

Select [Import] from the [File] menu on the Main Window and click a submenu [SMAF File...].  Select 

a SMAF file (*.mmf) to be imported for a music track from the “Open” dialog. 

 

Select [Import] from the [File] menu on the Main Window, then click [SMAF File...].  When the 

“Open” dialog appears, select a SMAF file (*.mmf) to be imported for a music track.  Click [OK] if the 

“Import SMAF File” dialog appears; thus, SCORE, PCM, and HV Track information are imported. 

When the importing process has been completed properly, a chart will be indicated in the Score Track 

Window, and the track type and the channel number are displayed in the Score Track Information 

Window.  If any error occurs, the importing process will be stopped with displaying a cause.  If any 

sound track has been already existed, all existing sound tracks will be cleared and a new imported 

data will be replaced. 

 

Contents information such as Copy status or a Music title can be also imported if "Import contents 

information also" is validated in the “Import SMAF file” dialog. 

 

[NOTE] 

Only an HV or Audio Note in the imported Score Track and a channel status can be edited directly.  

For further information about editing, please edit the Event by using the Sound Authoring Tool if 

needed.. 
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Chapter 5 -----  Editing Graphics Track 
 

Graphics Track can be edited in either the Main Window or the Block Edit Window.  On the Main 

Window, all objects included in the contents are displayed in a chronological order.  Events on the 

time-axis are indicated in the Page Edit Window regardless of Blocks.  Therefore, the overall flow of 

contents can be understood easily. 

On the other hand, editing is carried out in a block unit in the Block Edit Window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Editing in the Main Window 
 

1.1. Setting Backdrop Color 
 

1.1.1. Adding Backdrop Color 
Place the [E] mark on the time-axis where you desire to define the backdrop color, and then select 

[Edit]  [Backdrop Color]  [Add].  The “Backdrop Color” dialog opens.  The Backdrop color of 

that area can be set up by designating the target color. 

Page Edit Pane 
Graphics Track 

Edit Pane
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1.1.2. Modifying Backdrop Color 
Place the [E] mark on the time-axis where you desire to modify the backdrop color.  Select [Edit]  

[Backdrop Color]  [Modify] to open the “Backdrop Color” dialog.  The color of the area can be 

changed by designating the target color. 

 

1.1.3. Deleting Backdrop Color 
Place the [E] mark on the time-axis where you desire to delete the backdrop color.  Select [Edit]  

[Backdrop Color]  [Delete], and then the “SCAS” confirmation dialog box opens.  Click [OK] to 

delete the Backdrop color defined after the [E] mark.  

 

1.1.4. Changing Backdrop Color Display Time 
Backdrop color display time can be changed by dragging the border line of the Backdrop color in the 

Main Window.  When dragging operation passes the border line of the two different Backdrop colors 

right next to each other, that Backdrop color in the dragged area will be deleted whereas the color in 

the dragging area will be replaced.  

 

 

1.2. Operation of a Block 
A “Block” here is the unit of data to edit in the Graphics Track and considered to be a chunk of split 

contents in a time base. 

It becomes much easier to see and edit the contents if each (bigger) Block is split into smaller pieces 

depending upon the amount of texts or images. 

When the lyric data has been imported from a file by using import functions, all data in the Graphics 

Track will be cleared momentarily, and a new block is created automatically. 

 

1.2.1. Creating a Block 
In order to create a new block, it is necessary to select the Graphics Track Window beforehand.  A 

new Block can be created by either selecting [Edit]  [Create Block] or clicking the [Create Block] 

button on the Edit Bar. 

A Block will be created at the [E] mark in the Graphics Track Window.  The [E] mark is shifted by 

either right-clicking on the time-axis in the Main Window or left-clicking in the Graphics Track Edit 

Window. 

 

1.2.2. Selecting a Block 
In order to operate a Block, it is necessary to select the Block to be edited beforehand.  To select a 

Block, left-click over the Block name in the Graphics Track Window.  The selected Block changes its 

color from dark gray to light gray.  Multiple Blocks can be selected by [ctrl] + left-click. 
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1.2.3. Deleting a Block 
In order to delete a Block, click the Block to be deleted and select [Edit]  [Delete Block] from the 

menu or click a [Delete Block] button on the Edit Bar.  A [DEL] key and [D] key on the keyboard have 

the same way to work. 

 

1.2.4. Copying/Cutting a Block 
In order to copy a whole Block, click the Block to be copied and select [Edit]  [Copy] from the menu 

or click the [Copy] Button on to the Edit Bar.  A whole block is copied on the clip board.  In the case 

of [Cut], the Block is deleted from the screen and copied on to the clip board. 

 

1.2.5. Pasting a Block 
The Block copied on the clip board is pasted into an insertion point (position of the [E] mark) by 

selecting [Edit]  [Paste] from the menu or clicking the [Paste] button on the Edit Bar. 

 

1.2.6. Pasting a Block: Paste Special 
A Block copied on the clip board can be pasted by selecting its form.  Select [Edit]  [Paste Special] 

from the menu, and then the “Paste Special Data” dialog will appear. 

 

1.2.6.1. Pasting a Block 
The Block copied on the clip board is pasted into an insertion point (position of the [E] mark). 

When the copied Block on the clip board includes Images, Image Tiles, Bitmaps, or Bitmap Tile 

Events, any Event which its reference picture number is not registered can not be pasted. 

 

1.2.6.2. Pasting a Block: Images and Bitmaps 
As well as the Block copied on the clip board is pasted into an insertion point (position of [E] mark), 

the image related to the Event is automatically registered.  Only when images, Image tiles, Bitmaps, 

or Bitmap Tile Events are included in the Block in the clip board, the [Block paste with image and 

bitmap] menu appears in the “Paste Special Data” dialog. 

 

 

1.2.7. Moving a Block 
A Block can be moved only within the Graphics Track Window.  Select a Block to be moved.  And 

then drag it by holding the left-button of the mouse so that the Block can be moved.  Multiple Blocks 

can be moved at a time. 

 

1.2.8. Changing Lifetime for a Block 
Lifetime of a Block is displayed by button-downing the drag-corner at the right bottom of a Block.  A 

scale of Display time, Lifetime, and Wipe time of all Events in the Block can be changed in the same 

magnification just by dragging it. 
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1.2.9. Changing Display Time for a Block 
Block’s Display Time and Lifetime can be modified by dragging the left-below drag corner of the Block 

by a mouse.  (Block’s end time remains the same.) 

 

1.2.10. Changing a Block Name 

 

Select a Block, then select [Edit]  

[Change Block Name] from the menu, 

so that the “Block Name Change” 

dialog opens.  Any arbitrary character 

strings can be designated as a Block 

name here. 

 

 

1.2.11. Merging a Block 

Select a Block, then select [Edit]  

[Merge Blocks] from the menu, so that 

the “Block Merge” dialog opens.  Select 

a desired Block to be merged.  Two 

Blocks are merged into one. 

*It works only when multiple Blocks 

(more than one) exist in the Graphics 

Track. 
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1.2.12. Splitting a Block 

 
 

Select a Block and then choose [Edit]  [Split Block] from the menu.  The “Block Split” dialog opens. 

In the “Block to be split” window (left), Events in the Block are displayed in a chronological order.  

Select any Event to be split from the left list, then transfer it into the “New block to split” window 

(right).  The Name of the Block in the “New block to split” window can be changed. 

* It works only when multiple Events exist in a Block. 

 

1.3. Operation of an Event 
Multiple display objects can be placed within a Block.  Events of texts and images are pasted within 

a Block along with the time-axis.  When the lyric data is imported from a file by using the import 

functions, a new text event will be created automatically. 

 

In the Page Edit Window, the editing process mainly on the window such as Event layout is 

performed. 

In the Graphics Track Window, the editing process mainly on the time-axis such as creating a new 

Event and changing Display time and Lifetime is performed. 

The operation to create, delete, copy, and paste an Event can be carried out commonly in both 

windows. 

 

1.3.1. Operation in the Graphics Track Edit Pane 
 

1.3.1.1. Creating an Event 
A new Event is created.  Go to [Event]  [New] from the menu to select a type of the Event or click 

the button of creating each Event on the Tool Bar.  Then, the setup dialog of each selected Event 

opens.  Set up the attribute or effect of the Event here.  A new Event is created after clicking [OK].  

*In order to create a new Event, a desired Block needs to be selected beforehand. 
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<<Reference: “0”>> 

Type of Events Text Event 

Text Block Event  

Bitmap Text Event 

Image Event 

Image Tile Event 

Bitmap Event 

Bitmap Tile Event 

Rectangle Event 

Type of Event Effects Wipe  

Wipe Sequence 

Banner 

Blink 

Color Blink 

Fade 

Move 

1.3.1.1.1. Creating an Event by Dragging and Dropping 

By dragging and dropping a text file/ an image file/ a binary bitmap file/ an HV-Script file/ an audio 

file, the dialog to designate an Event type is displaed.  By choosing a desired Event to be created and 

then clicking the [OK] button, the setting dialog for the selected Event is displayed.  Here, by 

performing Event attribute and effect setups and then clicking the [OK] button, an Event can be 

created at the location of the [E] mark (Edit mark). 

※ If there is no Block, a new one is also created. 

 

<Reference： A type of Events created by dragging and dropping your desired file> 

Text File Text Event 

Text Block Event 

Bitmap Text Event 

Image File Image Event 

Image Tile Event 

Binary Bitmap File Bitmap Event 

Bitmap Tile Event 

HV-Script File ※ HV Event 

Audio File ※ Audio Event 

*The Event is created on the Score Track Window although it can be dragged and dropped on the 

Graphics Track Edit Pane. 
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1.3.1.2. Selecting an Event 
More than one Event can be selected at a time.  To select one Event, move the mouse cursor to an 

Event bar and left-click it.  To select multiple Events, drag the mouse cursor on the Graphics Track 

Window.  The selection range frame is displayed.  Multiple Events become in a state of ‘selecting’ by 

dropping with putting a target Event into the selection range.  The frame of the selected Events is 

surrounded by a white line.  Multiple Events between Blocks can be selected as well. 

 

1.3.1.3. Changing Display Time 
When moving the mouse cursor to the center of the Event bar, an icon changes its shape into a hand.  

Left-click the Event bar with the hand icon, and then drag it right/left to move the Event bar.  Display 

Time can be changed while the location of the Event bar is changed.  Multiple Events can be moved 

at a time. 

 

1.3.1.4. Changing Display Start Time 
When moving the mouse cursor to the left side of the Event bar, an icon changes its shape into a big 

white arrow.  Left-click the Event bar with the arrow icon, and then drag it right/left to expand or to 

shorten the Event bar.  Display Start Time can be changed while the lengths of the Event Bar is also 

changed. 

 

1.3.1.5. Changing Lifetime 
When moving the mouse cursor to the right side of the Event bar, an icon changes its shape into a 

double arrow.  Left-click the Event bar with the arrow icon, and then drag it right/left to expand or to 

shorten the Event bar.  Lifetime can be changed while the length of the Event bar is also changed. 

 

1.3.1.6. Changing Wipe Time 
When moving the mouse cursor to the Wipe mark of the Event bar, an icon changes its shape into an 

arrow.  Left-click it with the arrow icon, and then drag it right/left to move the Wipe mark.  Wipe 

Time can be changed while the mark is also moved. 

 

1.3.1.7. Changing Wipe Sequence Time 
If moving the mouse cursor to the Wipe Sequence mark of the Event bar, an icon changes its shape 

into an arrow.  Left-click it with the arrow icon, and then drag it right/left to move the Wipe 

Sequence mark.  Wipe Sequence Time can be changed while the mark is also moved. 

 

1.3.1.8. Moving an Event between Blocks 
An Event can be moved between the Blocks by left-clicking the center of the Event bar and then 

dragging/dropping it into the other Block.  Multiple Events can be selected and moved at a time. 
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1.3.1.9. Deleting an Event 
An Event can be deleted by selecting an Event bar and then clicking the [DEL] or [D] key on the 

keyboard.  Multiple Events can be selected and deleted at a time. 

 

1.3.1.10. Copying/Cutting an Event 
An Event can be copied on the clip board by selecting the Event bar and then going to [Edit]  [Copy] 

from the menu or clicking the [Copy] button on the Tool Bar.  For cutting, the Event is deleted from 

the screen and copied on to the clip board.  Multiple Events can be operated at a time. 

 

1.3.1.11. Pasting an Event 
An Event copied on the clip board can be pasted by selecting [Edit]  [Paste] from the menu or 

clicking the [Paste] button on the Toolbar. 

 

1.3.1.12. Pasting an Event: Paste Special 
The vent information copied on the clip board can be pasted in various forms.  Select an Event or a 

Block and then go to [Edit]  [Paste Special] from the menu.  The “Paste Special Data” dialog 

appears. 

 

1.3.1.12.1. Pasting an Event 

An Event copied on the clip board can be pasted into the selected Block.  When images, image tiles, 

bitmaps, or bitmap tile events are pasted, the image data number for the Event must be registered. 

1.3.1.12.2. Pasting an Event with Images and Bitmaps 

As well as an Event copied on the clip board is pasted into the selected Block, the image for the Event 

is automatically registered.  Only when images, image tiles, bitmaps, or bitmap tile events is 

included on the clip board, the [Event paste with image and bitmap] menu appears in the “Paste 

Special Data” dialog. 

 

1.3.1.12.3. Pasting a Color Attribute 

When selecting [Edit]  [Paste Special] in the selected Event, the "Paste color attribute" menu 

appears in the [Paste With Appointed Form] dialog.  When selecting “Paste color attribute” and then 

clicking [OK], the color attribute of the selected Event is replaced by the color attribute of the Event in 

the clip board.  Multiple Events can be selected and pasted at a time. 

 

1.3.1.12.4. Pasting a Color Attribute (to all Events in a Block) 

When selecting [Edit]  [Paste Special] in the selected Block, the "Paste color attribute to all events 
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in block" item appears in the [Paste With Attribute File] dialog.  When selecting “Paste color attribute 

to all events in block” and then clicking [OK], the color attribute of the selected Event is replaced by 

the color attribute of the Event in the clip board.  Multiple Events can be selected and pasted at a 

time. 

 

1.3.1.13. Other Event Operation 
The following operation methods are as same as these in the Block Edit Window.  For more details, 

please refer to "2. Block Edit Window". 

 

In the following item of the [Event] menu, operation is executed only when a Block is selected.  

- Load 

 

In addition, in the following items in the [Event] menu and the [Edit] menu, operation is executed 

only when an Event is selected.  

 

- [Event] menu (a button of Object Edit Bar)  

- Save  

- Attribute  

- Move Sequence  

- Split Text  

- Merge Text  

- Align Left  

- Centering  

- Align Right  

 

- [Edit] menu  

- Paste Text  

- Paste Special 

 

1.3.2. Operation in the Page Edit Pane 
 

1.3.2.1. Selecting and Moving an Event 
Move the mouse cursor to an Event bar then left-click it.  The selected Event can be moved by 

dragging and dropping it so that the display place can be also moved. 

 

1.3.2.2. Deleting an Event 
After selecting an Event bar, click a [DEL] or [D] key on the keyboard or the delete button on the 

Object Edit Bar. 
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1.3.2.3. Copying / Cutting an Event 
For copying, after selecting an Event bar, go to [Edit]  [Copy] from the menu or click the [Copy] 

button on the Tool Bar.  For cutting, after selecting an Event bar, go to [Edit]  [Cut] or click the 

[Cut] button (scissors icon) on the Tool Bar.  The selected Event is deleted from the screen and 

copied on to the clip board. 

 

1.3.2.4. Pasting an Event 
An Event which copied on the clip board is pasted in to the selected Block.  Select [Edit]  [Paste] 

from the menu or click the [Paste] button on the Tool Bar. 

 

1.3.2.5. Other Event Operation 
The following operation methods are as same as these in the Block Edit Window.  For more details, 

please refer to "2. Block Edit Window". 

 

- [Event] menu (a button on the Object Edit Bar)  

- Load  

 

In the following items, operation is executed only when an Event is selected. 

- Event Size Change (Rectangle Event, Text Block Event)  

- Edit Move Sequence  

- [Event] menu (a button on the Object Edit Bar)  

- Save  

- New 

- Attribute  

- Move Sequence  

- Split Text  

- Merge Text  

- Align Left  

- Centering  

- Align Right  

- [Edit] menu  

- Paste Text  

- Paste Special  

 

In the following items, operation is executed only when a Block is selected.  

- [Event] menu (a button on the Object Bar)  

- Automatic Layout 

 

1.3.3. Operation in the Graphics Track Edit Pane & Page Edit Pane 
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1.3.3.1. Plane functions 
The Event of the designated plane is un-editable if clicking the [Plane] button or selecting [View]  

[Plane].  Any Events in the un-editable plane are shaded in gray.  Use this function when the 

particular Plane needs to be edited. 

 

 

2. Editing in the Block Edit Window 
 

Any Blocks and Events created in the Graphics Track can be edited. 

In order to edit a Block, after selecting a Block in the Graphic Track Window, go to [Edit]  [Edit 

Graphics Block], click the [Graphics block edit] button on the Edit Bar, or double-click the selected 

Block, so that the [Block Edit] dialog appears.  The right side of the [Block Edit] window (dialog) is 

for editing the time arrangement of the graphic object.  And the left side of the window is for editing 

the layout of the graphic objects.  The frame with a straight line is the authoring rendering size, 

whereas the one with a dotted-line is the output RS tag size.  These are changeable in the Contents 

Information dialog. 

Plane Designation
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2.1. Common Operation in the Block Edit Window 
 

2.1.1. Creating an Event 
A new Event is created by selecting a type of Event from [Event]  [New], clicking the button of each 

Event on the Tool Bar, or selecting a type of the Event from the pop-up menu displayed by 

right-clicking.  Then, the setup dialog of each corresponding Event opens.  The attribute or effect 

setting of the Event is performed here.  A new Event is created when clicking [OK]. 

 

Type of Events Text Event 

Text Block Event 

Bitmap Text Event 

Image Event  

Image Tile Event 

Bitmap Event  

Bitmap Tile Event  

Rectangle Event 

Type of Event Effects Wipe  

Wipe Sequence  
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Banner  

Blink  

Color Blink  

Fade  

Move 

  

2.1.1.1.1. Creating an Event by Dragging and Dropping 

By dragging and dropping a text file/ an image file/ a binary bitmap file, the dialog to designate an 

Event type is displayed.  By choosing a desired Event to be created and then clicking the [OK] 

button, the setting dialog for the selected Event is displayed.  Here, by performing Event attribute 

and effect setups and then clicking the [OK] button, an Event can be created at the location of the 

[E] mark (Edit mark). 

※ If there is no Block, a new one is also created. 

 

<Reference： A type of Events created by dragging and dropping your desired file> 

Text File Text Event 

Text Block Event 

Bitmap Text Event 

Image File Image Event 

Image Tile Event 

Binary bitmap file Bitmap Event 

Bitmap Tile Event 

 

2.1.2. Editing an Event 
An Event can be edited by double-clicking the Event bar or going to [Attribute] from the Event menu. 

For more information, please refer to "3. Edit Event".  

 

2.1.3. Saving an Event 
An Event can be saved as an Evt file (*.evt), a Csv File (*.csv), or Csv File (Even Slect) (*.csv) by 

selecting [Event]  [Save].  Multiple Events can be selected and saved at a time.  

 

2.1.4. Loading an Event 
The saved Event file (*.evt or *.csv) can be loaded into the displayed Block by selecting [Event]  

[Load].  

 

2.1.5. Deleting an Event 
An Event can be deleted by selecting the desired Event bar by choosing the [DEL] or [D] key on the 

keyboard.  Multiple Events can be selected and deleted at a time. 
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2.1.6. Copying/ Cutting an Event 
An Event can be copied on to the clip board by selecting [Edit]  [Copy] from the menu or choosing 

the [Copy] button on the Tool Bar.  In the case of [Cut], the Event is deleted from the screen and 

copied on to the clip board.  Multiple Events can be selected and copied/cut at a time.  

 

2.1.7. Pasting an Event 
An Event which has been copied on the clip board can be pasted into the displayed Block by selecting 

[Edit]  [Paste] from the menu or clicking the [Paste] button on the Tool Bar. 

 

2.1.8. Pasting a Text 
When any character string is copied on the clip board, the string in the clip board can be pasted into 

the displayed Block as a Text Event, by selecting [Edit]  [Paste Text] from the menu.  One text 

event can be created in one line of character string.  

 

2.1.9. Pasting Special 
The Event information which has been copied on the clip board can be pasted in various forms.  

After selecting an Event or a Block, go to [Edit]  [Paste Special] from the menu.  The “Paste With 

Appointed Form” dialog appears. 

 

2.1.9.1. Pasting an Event 
An Event copied on the clip board can be pasted into the selected Block.  When images, image tiles, 

bitmaps, or bitmap tile events are pasted, the image data number for the Event must be registered. 

 

2.1.9.2. Pasting an Event with images and bitmaps 
As well as an Event copied on the clip board is pasted into the selected Block, the image for the Event 

is automatically registered.  Only when images, image tiles, bitmaps, or bitmap tile events is 

included on the clip board, the [Event paste with image and bitmap] menu appears in the “Paste 

Special Data” dialog. 

 

2.1.9.3. Pasting a color attribute 
When selecting [Edit]  [Paste Special] in the selected Event, the "Paste color attribute" menu 

appears in the [Paste With Appointed Form] dialog.  When selecting “Paste color attribute” and then 

clicking [OK], the color attribute of the selected Event is replaced by the color attribute of the Event in 

the clip board.  Multiple Events can be selected and pasted at a time. 
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2.1.10. Splitting a Text 
When the data is imported from an XF file, the imported text may run off the edge of the screen 

because it is too long.  In this case, the text can be split at your desired position. 

 

 

After selecting a Text Event to be split, the Text Split dialog is displayed by selecting [Event]  [Split 

Text] from the menu or choosing the [Split Text] button on the Tool Bar.  The selected Text Event 

(character strings) is shown in the dialog box.  Set a cursor to anywhere in the text line to be split, 

and then click [OK] to get the text split.  At this time, nothing would occur if the mouse cursor is at 

the beginning of or at the end of the text line. 

 

There is another way to split the text in the Page Edit Window.  Left-click on the Text Event where to 

be split and hold it down for more than one second.  The Text will be split automatically, and a new 

Text Event is created from the beginning of the letter which has been clicked.  Nothing would occur 

if the mouse cursor locates at the beginning of or at the end of the text. 

In both methods, each attribution such as Display Time maintains as it used to be within the two 

separated Text Events. 

In addition, the Event on the left is selected after splitting. 

 

2.1.11. Merging Texts 
Two Text Events are merged into one. 

 
 

Select a Text Event to merge, then select [Edit]  [Merge Text] from the menu, or click the [Merge 
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Text] button on the Tool Bar.  The [Text Merge] dialog opens.  All possible Texts to be merged, not 

the selected one, are listed in the window.  Select a desired text to be merged and click [OK].  The 

Text to merge will be combined into the text to be merged. 

 

The merged text is [the text to be merged] + [the text to merge].  Any attribution such as Display 

Time of [the text to be merged] maintains into the new text. 

 

2.1.12. Changing Editing Blocks (Switch Pages) 
All Blocks in the contents file are tab-displayed at the bottom of the dialog.  In the above example, 

the contents file consists of five Blocks.  The most top Block is in edit.  The editing Block is switched 

by selecting the tab at the bottom of the window.  It can be also switched by selecting [Previous 

Block] and [Next Block] from the menu [View] or clicking the arrow-head buttons on the Tool Bar. 

 

2.1.13. Plane Functions 
The designated Plane Event is turned uneditable by selecting [View]  [Plane] or clicking the [Plane] 

button.  Uneditable Plane’s Event is displayed in shaded gray.. 

 

 

 

Set up to be uneditable.

Events on Plane 2 are displayed in 

shaded gray.
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2.2. Operation in the Page Edit Pane 
 

2.2.1. Selecting and Moving an Event 
In order to select an Event, left-click the desired Event.  The Event can moved, and its display 

position can be changed also by holding and dragging the mouse. 

 

2.2.2. Changing the Event Size 
The Size for the Rectangle Event and the Text Block Event can be changed.  When selecting these 

Events by going to [Event]  [New], there is a small cubic dot displayed on each corner of the Event.  

When putting the mouse cursor over any one of these dots, the cursor changes its appearance into a 

double-arrow –head shape.  The size of Event can be changed by holding and dragging the arrowed 

cursor. 

 

2.2.3. Editing the Move Sequence 
The Move Sequence which has been set up in the Event can be edited on the screen.  When 

selecting an Event, the path of the Move Sequence along the coordinate system and its move time are 

displayed. (When the Move Sequence is not set up, nothing will be displayed.)  The position of the 

move destination can be changed by dragging and dropping the moving point.  

Moreover, Move Sequence edit or setup also can be performed by selecting [Event]  [Move 

Sequence] or selecting [Move Sequence] from the pop-up menu which is opened by right-clicking the 

Event. 

 

2.2.3.1. Add… 
The Move dialog appears for the Move Sequence. 

(The coordinate values at the right-click will be the initial value.  When the [Move] dialog is opened 

from the Event menu, the initial values are "0".) 

 

2.2.3.2. Modify… 
The [Move] tab of the [Text Block Event] dialog is displayed. 
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2.2.3.3. Synchronize with an Event 
Switch the setup whether the move destination position of the Move Sequence can be synchronized 

with the move of the Event. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.4. Individual Layout for the Event 
After selecting a desired Event, the Event position can be changed by selecting [Align Right], 

[Centering], or [Align Left] from the [Event] menu or by clicking a desired layout button on the Tool 

Bar.   

 

2.2.4.1. Automatic layout of the Text Event 
The Text Event included in the page is positioned automatically.  After selecting a desired Block, go 

to [Event]  [Auto Layout] from the menu or click the [Auto layout] button.  The [Select Layout 

Style] dialog opens.  Designate an layout style and then click [OK] to set it up automatically.  

 

2.2.4.2. Changing Magnification 
It would be very difficult to edit Blocks on the PC screen because the contents in an actual size (a 

mobile phone) are too small.  In SCAS, the display magnification can be changed to [x1], [x2], [x3], 

and [x4].  Select [View]  [Magnification] or click one of the magnification buttons on the Tool Bar.  

 

2.2.4.3. Page Edit Operation by a Keyboard 
In the Page Edit Pane, the following operation keys can be used;  

 

[TAB]: Selects an Event.  An earlier Event is selected by each click.  

Add 

Modify
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[←][↑][→][↓]: Moves an Event upward, downward, left and right.  

[Page Up][Page Down]: Switches the page (Block) upward and downward.  

[DEL]: Deletes a selected Event.   

[A]: Opens the Setup dialog for the selected Event.  

[C]: Aligns an Event to the center.  

[L]: Aligns an Event to the left.  

[R]: Aligns an Event to the right.  

[BS]: Merges the selected Text Event into the Text Event located just before it.  

[SHIFT] + [BS]: Merges the selected Text Event into the Text Event located just after it. 

 

2.3. Operation in the Time Edit Pane 
 

The lateral direction in the Time Edit window is a time-axis, which shows the time flow from the 

beginning of the contents.  The position of each Event on the time-axis is performed here.  An 

Event can be expressed a rectangular shape having its Lifetime, which is called an Event bar.  The 

Event bar shows Display Start Time beginning from left to right, whereas its length shows Lifetime. 

Moreover, in any Event capable of Wipe functions, the wipe mark [▼] is shown on the Event bar.  

 

2.3.1. Displaying the Timebase 
There are two display types of the Timebase: [Time Signature Display] and [Actual Time Display].  

To switch the display type, select [View]  [Display Timebase] from the menu.  Right after the Block 

Edit Window has opened, the Timebase is displayed on the same time-axis as the Main Window.  

 

2.3.2. Zooming the Timebase 
The width of the Timebase scale can be changed.  When selecting [Zoom In] or [Zoom Out] from 

the [View] menu, the scale width is changed.  The [+] and [-] buttons (a magnifying glass icon) on 

the Zoom Bar also have same function.  Its scale is changed continuously while keeping on holding 

the button.  

 

2.3.3. Selecting an Event 
Multiple Events can be selected at a time.  To select one Event, put the mouse cursor on to a desired 

Event bar and left-click it.  When selecting multiple Events, left-click a mouse, hold it down, and drag  

the mouse cursor on the Graphics Track Window.  When a selection frame appears, make it 

overlapped with the desired Events.  The frame of the selected Events is ruled off in white. 

 

2.3.4. Changing Display Time (Move Event） 
When left-clicking the left side of the Event bar and then dragging it right/left, Display Time can be 

changed.  The Event bar can be also moved up/down.  Selected multiple Events can be moved at a 

time.  

 



 70

2.3.5. Changing Lifetime 
When left-clicking the right side of the Event bar and then dragging it right/left, Lifetime of the Event 

can be changed.  

 

2.3.6. Changing Wipe Time 
When left-clicking the wipe mark on the Event bar and dragging it right/left, Wipe Time of the Event 

can be changed.  

 

2.3.7. Time Edit Operation by a Keyboard 
In the Time Edit part, the following operation keys can be used;  

 

[TAB]: Selects an Event.  An earlier Event is selected by each click.  

[←][↑][→][↓]: Moves an Event upward, downward, left and right.  

[Page Up][Page Down]: Switches the page (Block) upward and downward.  

[DEL]: Deletes a selected Event.   

[A]: Opens the Setup dialog of the selected Event.  
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3. Editing Event Information 
 

Modifiable information of the Event created in the Graphics Track Window is display as the Text Event 

dialog.  Although Display Time, Rough Time, Wipe Time, and Display Location can be modified on 

the aforementioned Graphics Track Window, the information about Color Attribute and Effect need to 

be set up by the Text Event dialog.  This dialog can be opened from the Graphics Track Window, the 

Page Edit Window, or the Block Edit Window.  After selecting a desired Event, double-click the Event 

or go to [Event]  [Attribute] to open the window.  When creating a new Event, the Text Event 

dialog opens as default. 

 

3.1. Setting an Event 
The attributes such as Wipe Color, Display Position, and Display Time of the Event at the time of 

display can be set up.. 

 

3.1.1. Text Event Setting 
 

 

 

Text The text to be displayed is entered.  

Parameter The Parameter type for the Event is designated.  The color attribute and 

the coordinate system, which have been set into the parameter of Track 
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information, are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information.  

Font size The font size of the text is designated.  The imputable range is from 2 to 

254.  If the font size is other than 12, external characters can not be 

entered. 

Display direction The display direction of the text is selected.  It is fixed in "Horizontal” 

writing and can not be changed. 

Attribute The display attribute of the text is selected.  It is fixed in "Normal” and 

can not be changed.  

Text color / 

Background color 

The display color for the Text Event is designated.  The Edge color can 

not be changed.  

Transparent 

process 

The usage for the transparent process in the object and the transparent 

color are selected.  

Display time The duration time to display the text is selected.  The Display time is 

from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart.  

Life time This is time from the beginning of and to the end of the Text.  A unit is 

millisecond.  The Input range is from 0 to (Timebase x 16511).  The 

Timebase is the value set in the Graphics Track Information and can be 

changed.  

Display plane A Plane to locate the text is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate the text is designated.  The input range 

is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System. 

Coordinate system The coordinate system of the display position is designated.  Select one 

from the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 
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3.1.2. Text Block Event Setting 

 

 

Text The text to be displayed can be entered.  

In a Text Block, the line-feed can be executed by pressing the Enter key.  In 

addition, each line in the Block can be aligned to the left, center, or right by 

selecting a line and then clicking one of the layout buttons under the text 

box.  

Block Width The Block width is selected.  There are 3 ways to do so. 

Layout size fixed The width of Effective Display Area will be the 

default Block width.  The [Width] value can not be 

changed. 

Standard width The entered value will be the Block width. 

Layout size 

subtracted width 

The value (the entered value subtracted from the 

default width value of the Effective Display Area is 

designated. 
 

Spacing The space between strings is designated.  

Block background 

color 

The background color of the Block is designated.  

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information parameter 

are loaded. 

When using the same color attribute multiple times, extra setting work can 
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be reduced and also the data size can be saved if setting information (i.e. 

color attribute) is stored into the parameter by Graphics Track Information. 

Font size The font size of the text is designated.  The input range is from 2 to 254.  If 

the font size is other than 12, external characters can not be entered. 

Display direction The display direction of the text is selected.  It is fixed in "Horizontal” 

writing and can not be changed. 

Attribute The display attribute of the text is selected.  It is fixed in "Normal” and can 

not be changed.  

Text color / 

Background color 

The display color for the Text Event is designated.  The Edge color can not 

be changed. 

Transparent 

process 

The usage for the transparent process in the object and the transparent color 

are selected. 

Display time This is time from the beginning of and to the end of the Text.  A unit is 

millisecond.  The Input range is from 0 to (Timebase x 16511).  The 

Timebase is the value set in the Graphics Track Information and can be 

changed.  

Lifetime This is time from the beginning of and to the end of the Text.  A unit is 

millisecond.  The Input range is from 0 to (Timebase x 16511).  The 

Timebase is the value set in the Graphics Track Information and can be 

changed.  

Display plane A Plane to locate the text is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same Plane, 

the Event which comes later will be drawn over.  

Display position The coordinate system to locate the text is designated.  The input range is 

from -2048 to 2047 for both [X] and [Y] axises of the Standard Coordinate 

System and the Symmetrical Coordinate System.  The input range is from 0 

to 127 for both [X] and [Y] axises of the Layout Coordinate System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

from the Standard Coordinate System, the Symmetrical Coordinate System, 

or the Layout Coordinate System. 
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3.1.3. Bitmap Text Event Setting 

 

 

Text The text to be displayed can be entered.  Any font type can be freely 

selected since the font type is registered as a bitmap text. 

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information. 

Font size The font size of the text is designated.  

Text color / 

Background color 

The display color for the Bitmap Text Event is designated. 

Display time The duration time to display the text is selected.  The Display time is 

from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart. 
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Life time This is time from the beginning of and to the end of the Text.  A unit is 

millisecond.  The Input range is from 0 to (Timebase x 16511).  The 

Timebase is the value set in the Graphics Track Information and can be 

changed.  

Display plane A Plane to locate the text is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate the text is designated.  The input range 

is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

from the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 
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3.1.4. Image Event Setting 

 

 

Image Designation 

button 

An image to be displayed can be designated.  Select an image from the 

Image Designation dialog and then click [OK] to display the image. 

However, it is necessary to register the image into the Image Designation 

dialog beforehand.  

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information.  

Transparent 

process 

The usage for the transparent process to the image and the transparent 

color are selected.  

Display time The duration time to display an image is selected.  The Display time is 

from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart.  
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Lifetime This is time from the beginning of and to the end of the image display.  A 

unit is millisecond.  The Input range is from 0 to (Timebase x 16511). 

The Timebase is the value set in the Graphics Track Information and can 

be changed. 

Display plane A Plane to locate an image is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate an image is designated.  The input 

range is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

out of the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 
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3.1.5. Image Tile Event Setting 

 

 

Image Designation 

button 

An image to be displayed in tiles is designated.  Select an image from the 

Image Designation dialog and then click [OK] to display an image tile. 

However, it is necessary to register any image into the Image Designation 

dialog beforehand.  

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information. 

Transparent 

process 

The transparent process cannot be executed to the image tile at present 

condition.  

Display time The duration time to display an image tile is selected.  The Display time is 

from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart. 
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Lifetime This is time from the beginning of and to the end of the image tile display. 

A unit is millisecond.  The Input range is from 0 to (Timebase x 16511). 

The Timebase is the value set in the Graphics Track Information and can 

be changed.  

Display plane A Plane to locate an image tile is selected.  The Plane is a virtual layer, 

and Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over. 

Display position The coordinate system to locate an image tile is designated.  The input 

range is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System. 

Coordinate system The coordinate system of the display position is designated.  Select one 

out of the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 

 



 81

 

3.1.6. Bitmap Event Setting 

 
 

Bitmap 

Designation button 

A bitmap to be displayed is designated.  Select an image from the Bitmap 

Designation dialog and then click [OK] to display a bitmap.  However, it is 

necessary to register the image into the Bitmap Designation dialog 

beforehand. 

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information. 

Text color / 

Background color 

The display color for the Bitmap Text Event is designated. 

Since the image is a binary bitmap, the wipe color can be done just like 

the text.  

Transparent 

process 

The usage for the transparent process to the image and the transparent 

color are selected.   

Display time The duration time to display a bitmap is selected.  The Display time is 
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from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart. 

Lifetime This is time from the beginning of and to the end of the bitmap display. 

A unit is millisecond.  The Input range is from 0 to (Timebase x 16511). 

The Timebase is the value set in the Graphics Track Information and can 

be changed.  

Display plane A Plane to locate a bitmap is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate a bitmap is designated.  The input range 

is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

out of the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 
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3.1.7. Bitmap Tile Event Setting 

 

 

Bitmap 

Designation button 

A Bitmap to be displayed in tiles is designated.  Select an image from the 

Bitmap Designation dialog and then click [OK] to display the bitmap. 

However, it is necessary to register the image into Bitmap Designation 

dialog beforehand.  

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information.  

Text color / 

Background color 

The display color for the Bitmap Tile Event is designated.  The edge color 

can not be changed.  

Transparent 

process 

The transparent process cannot be executed to the bitmap tile at present 

condition.  

Display time The duration time to display a bitmap tile is selected.  The Display time is 
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from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart. 

Life time This is time from the beginning of and to the end of the bitmap tile 

display.  A unit is millisecond.  The Input range is from 0 to (Timebase x 

16511).  The Timebase is the value set in the Graphics Track Information 

and can be changed.  

Display plane A Plane to locate a bitmap tile is selected.  The Plane is a virtual layer, 

and Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate a bitmap tile is designated.  The input 

range is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

out of the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 
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3.1.8. Rectangle Event Setting 

 

 

Size The width and height of the rectangle Event is designated by a pixel unit. 

An input range is from 1 to 319 for both the [Width] and [Height].  

Color The color of the rectangle is designated.  

Parameter The Event Parameter type is designated.  The color attribute and the 

coordinate system which have been set in the Track Information 

parameter are loaded. 

When using the same color attribute multiple times, extra setting work 

can be reduced and also the data size can be saved if setting information 

(i.e. color attribute) is stored into the parameter by Graphics Track 

Information.  

Transparent 

process 

The usage for the transparent process to the image and the transparent 

color are selected.  However, even though the transparent color can be 

designated to the rectangle, no particular change is shown at a present 

condition.  

Display time The duration time to display a rectangle is selected.  The Display time is 

from the beginning of and to the end of a Block.  A unit is millisecond.  

Input range must be the value divisible by Timebase from 0 to 

(2097151-Lifetime).  The display start time of the Block can be checked 

by selecting the target Block in the Track Chart.  
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Lifetime This is time from the beginning of and to the end of the rectangle display. 

A unit is millisecond.  The Input range is from 0 to (Timebase x 16511). 

The Timebase is the value set in the Graphics Track Information and can 

be changed.  

Display plane A Plane to locate a rectangle is selected.  The Plane is a virtual layer, and 

Plane2 is always drawn over Plane1.  In any Event place on the same 

Plane, the Event which comes later will be drawn over.  

Display position The coordinate system to locate a rectangle is designated.  The input 

range is from -2048 to 2047 for both [X] and [Y] axises of the Standard 

Coordinate System and the Symmetrical Coordinate System.  The input 

range is from 0 to 127 for both [X] and [Y] axises of the Layout Coordinate 

System.  

Coordinate system The coordinate system of the display position is designated.  Select one 

out of the Standard Coordinate System, the Symmetrical Coordinate 

System, or the Layout Coordinate System. 

 

 

3.2. Event Effect Setting 
By setting up any effect as the modification information of the Event, specified operation can be done 

in replay.   

Although multiple effects can be specified at the same time, the following items can not be 

designated redundantly. 

- Wipe  

- Wipe Sequence  

- Color Blink 
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3.2.1. Wipe Effect Setting 
The color of an object in the middle of displaying can be changed.  When a new Text Event is created, 

the Wipe effect is effective. 

* The sample file is available.  Please refer to “Chapter 9 ----- Samples”. 

* The Wipe effect also can be set in “5.1 Wipe Edit”.  In addition, it is automatically set up when an 

XF file is imported.  

Applicable Event: Text, Text Block, Bitmap Text, and Bitmap. 

 

 

Wipe check box The Wipe effect Enabled/Disabled can be selected. 

Wipe time The Wipe time can be designated. . This is the time counted from the 

Event starting point.  A unit is millisecond.  An input range is from 0 to 

(Timebase x 16511).  

Text color after 

wipe / Background 

color after wipe 

The color for the text and the background after Wipe is designated.  Its 

edge color can not be changed at this moment. 
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3.2.2. Wipe Sequence Effect Setting 
The color of each character(s) can be changed in order as the lyrics wipe of KARAOKE.  

* Its sample file is available.  Please refer to “Chapter 9 ----- Samples”. 

* The Wipe Sequence effect is also set up automatically when an XF file is imported.  Please refer to 

“Chapter 4 ---- 3.1.2 importing an XF file”.  

Applicable Event: Text, Text Block, and Bitmap Text 

 

 

Wipe Sequence 

check box 

The Wipe Sequence effect Enabled/Disabled can be selected.  

Wipe Time The time to be wiped is designated to each character.  

The horizontal axis of the Wipe Sequence Information window shows a 

time-base.  The time-base is the time after the Event being displayed, 

and its unit is millisecond.  By dragging each character box left or right, 

each character can be moved into the desired time-base position for wipe. 

At this time, the Wipe time exceeding the Lifetime can not be set up. 

More than one character can be selected and then moved at a time.  

Designate number 

of characters to be 

wipe 

The number of characters to be wiped is selected.  When enabling the 

check box (Designate number of character to be wipe), the desired 

number of characters to be wiped can be changed.  When disabled, all 
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characters will be wiped.  

Text color after 

wipe / Background 

color after wipe 

The color for the text and background after Wipe is designated.  Its edge 

color can not be changed at this moment. 

 

 

3.2.3. Banner Effect Setting 
An object can be moved within a certain display area as a banner.   

* The sample file is available.  Please refer to “Chapter 9 ----- Samples”. 

Applicable Event: Text, Text Block, Image, Bitmap, and Rectangle. 

 

 

Banner check box The Banner effect Enabled/Disabled can be selected.  

Banner style Either a horizontal or vertical banner style is selected. 

Display direction The moving direction of a banner can be designated.  In a horizontal 

banner with a positive direction, the display object moves from right to 

left.  In a horizontal banner with a negative direction, it moves from left 

to right.  In a vertical banner with a positive direction, it moves from 

bottom to top.  In a vertical banner with a negative direction, It moves 

from top to bottom.  

Turn When selecting a positive direction turn with a positive direction banner, a 
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display object will be displayed repeatedly and infinitely.  On the other 

hand, when selecting a negative direction turn with a negative direction 

banner, a display object also will be displayed repeatedly and infinitely.  

Backdrop color The background color while the banner is executed is designated. . The 

color can be changed in the Image or Rectangle Event.  

Window size The width (for a horizontal banner) or height (for a vertical banner) of the 

window for the banner display are selected.  There is nothing to do with 

the selected display object or the text length.  Only the sized of the 

banner display can be selected. . An Input range is from 0 to 16511.  

Margin size An interval space between objects (how much of the space in-between 

needed) can be designated.  Its unit is dots.  An input range is from 0 to 

16511.  

Banner start 

position 

The start position of the banner is selected.  In a banner the top left 

point of the display object is the origin.  Then, designate to see whether 

the position of the display object is displayed at its top left origin of the 

banner window for the display start time.  

For example, if a space is initially displayed and then the display object is 

appeared from the right end with the horizontal banner, the negative 

value, which the banner start position is more than the width of the 

window size, needs to be selected. 

An input range is from -2048 to 2047.  

Moving distance The moving distance of display object from the beginning of and to the 

end of the banner is designated in dots.  If designating 0, the object 

keeps on moving during an entire Lifetime.  An input range is from 0 to 

16511.  

Banner time The time for operating the banner is designated.  The speed of a banner 

is the value which is divided the moving distance by time.  If designating 

0 for the moving distance, its speed is considered to be the moving time 

per 100 dots.  An input range is from 0 to (Time Base x 16511). 
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3.2.4. Blink Effect Setting 
The display object blinks on and off repeatedly.. 

* Its sample file is available.  Please refer to “Chapter 9 ----- Samples”.  

Applicable Event: Text, Text Block, Image, Bitmap, and Rectangle 

 
 

Blink check box The Blink effect Enabled/Disabled can be selected. 

Display time The time of displayed status (blink on) is designated by millisecond.  An 

input range is from 100 to (Time Base x 16511).  

Non-display time The time of non-displayed status (blink off) is designated by millisecond. 

An input range is from 100 to (Time Base x 16511).  

Blink count The count for the status change cycle (blink on  blink off  blink on) is 

designated.  If designating 0, the object keeps on blinking during an 

entire Lifetime.  An input range is from 0 to 16511. 
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3.2.5. Color Blink Effect Setting 
The normal text color and after-wipe text color are displayed repeatedly to the display object.  This is 

sort of a color blinking effect. 

* The sample file is available,  Please refer to “Chapter 9 ----- Samples”.  

Applicable Event: Text, Text Block, and Bitmap 

 

 

Color blink check 

box 

The Color Blink effect Enabled/Disabled can be selected. 

Normal display 

time 

The normal display time for color blink is displayed by a unit of 

millisecond.  An input range is from 100 to (Time Base x 16511).    

Wipe display time The wipe display time for color blink is designated by a unit of millisecond. 

An input range is from 100 to (Time Base x 16511).   

Blink count The count of the status change cycle (Normal  Blink  Normal) is 

designated.  If designating 0, the object text keeps on blinking during an 

entire Lifetime.  An input range is from 0 to 16511. 
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3.2.6. Fade Effect Setting 
The fade-in/out effect of the object is displayed. 

* Its sample file is available.  Please refer to “Chapter 9 ----- Samples”.  

Applicable Event: Text, Text Block, Image, Bitmap, and Rectangle 

 

 

 

 

Fade check box The Fade effect Enabled/Disabled can be selected. 

Fade-in style A type of fade-in operation is designated.  

Fade-In time The time which is from the beginning of the fade-in effect to the 

full-display is designated.  An input range is from 0 to (Time Base x 

16511). 

Fade-out style A type of the fade-out operation is designated.   

Fade-out time The time which is from the beginning of the fade-out effect to its complete 

disappearance is displayed.  An input range is from 0 to (Time Base x 

16511). 
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3.2.7. Move Sequence Effect Setting 
The effect is displayed by moving an object text.  In terms of the movement of the display position, 

the constant-velocity movement is performed. 

* Its sample file is available.  Please refer to “Chapter 9 ----- Samples”.  

Applicable Event: Text, Text Block, Image, Bitmap, and Rectangle 

 
 

Move step The interval for display update time is designated in the movement of an 

object.  If designating 0, an object moves as smooth as possible regardless 

of the terminal.  An input range is from 0 to (Time Base x 255).  

Move sequence list The move sequence is performed in a listed order.  The maximum number 

of the entry is 20.  

Add button An entry is added on to the move sequence list.  

Change button An already existed entry on the move sequence list is modified.  

Delete button A selected entry is deleted.  

Upward button The selected entry is shifted upwardly.  

Downward button The selected entry is shifted downwardly.  

Setup Property of 

Move Sequence 

 

Where to move 

(X/Y Coordinate 

Each coordinate of move destination is selected. 

An input range is from -2048 to 2047 for both [X] 
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system) and [Y] of the Standard Coordinate System and the 

Symmetrical Coordinate System, whereas 0 to 127 

for [X] and [Y] of the Layout Coordinate System.  

Move Time The traveling time to next move destination is 

designated.  If designating 0, it moves momentary. 

An input range is from 0 to (Time Base x 16511). 
 

 



 96

 

4. Registering the Image Data 
In order to paste any image data into an Event, the image dada should be registered.  Register any 

images beforehand to create the Image Event, Image Tile Event, Bitmap Event, and Bitmap Tile 

Event. 

 

4.1. Object Registration 
Images and bitmaps used in the Graphics Track are registered as objects.  The form of the image 

data which can be registered by SCAS is PNG, JPEG, and Windows Bitmap. 

 

Format Conditions 

PNG Type3IndexColor is recommended. 

Transparent Alpha-Channel PNG is not recommended. 

Interlace PNG is unloadable 

JPEG Progressive JPEG is unloadable. 

Bitmap Windows Bitmap. (Only binary (monochrome) image is loadable.) 

 

If the contents can not be performed correctly on a mobile phone, although it can be normally so on 

SCAS, refer to the documentation provided by product carriers or terminal makers. 

 

Select [Object Registration...] from the [Tool] menu on the Main Window.  The [Object Registration] 

dialog opens.  Click the [Registration] button and then select a desired image file from the [Open] 

dialog.  An object can also be registered by dragging and dropping a file on to the dialog from 

Windows Explorer.  By using this method, multiple files can be registered at a time.  Any 

image/object checked in the checkbox indicates its status of use and cannot be deleted either. 
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List Title The registered images/bitmaps are rearranged by clicking the list title. 

Registration 

button 

A new image is registered.  Select a desired image file to be registered 

after opening the [Open] dialog. 

Replace button The image data which has already been registered can be replaced to 

another one.  Select an image/bitmap and click the [Replace] button. 

Select a desired image/bitmap file to be replaced when the [Open] dialog 

appears.  

* JPEG or PNG can not be switched to Bitmap and vice versa.  

Export button The image/bitmap data which has already been registered is exported 

into another file.  Select an image/bitmap and click the [Export] button. 

Designate the file name when the [Save As] dialog appears.  The file will 

be exported and saved as the same file format. 

Change Number 

button 

The number of an image/bitmap which has already been registered is 

changed.  Select an image/bitmap and click the [Change Number] 

button.  The [Change Object Number] dialog appears.  Then click the 

[Change Number] bottom.  Enter a new number from the list of 

numbers. 

Delete button The image/bitmap which has already been registered is deleted.  Select 
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an image/bitmap and click the [Delete] button.  A [DEL] key on the 

keyboard also has the same function.  

* The image data used in the active Events can not be deleted.  

Sort button The ID number assigned for the registered images/bitmaps are sorted by 

the current display order.  

OK button The changes are reflected in and the dialog is closed. 

Cancel button All changes made are cancelled and the dialog is closed. 
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5. Editing Whole Contents 
 

Some editing tools are available for authoring contents in SCAS.  By using these tools, an entire 

contents is brought to completion, checking display overlaps or adjusting Wipe Timing. 

In addition, make sure to set up the contents information to created contents. 

 

 

5.1. Wipe Edit 
This tool is for synchronizing the Wipe Time of the text with the music playback. 

Select [Tool]  [Wipe Edit…] from the menu of the Main Window or click the [Wipe Edit] button on 

the Tool Bar. 

 

 

In the [Wipe Edit] dialog, the character strings for the Text Events and Text Block Events included in 

the Track are displayed in chronological order.  Each Event is displayed as a rectangle containing the 

length of Lifetime, that is called an Event Bar.  The position of the Event Bar indicates display start 

time, whereas its length indicates Lifetime.  In terms of any Event with the Wipe effect, a Wipe mark 

[▼] is shown on the Event Bar.  The color of the Event Bar indicates: before Wipe on the left side of 

the mark and after Wipe on the right side of the mark.  Each character string is displayed in the gray 

bar.  A flag for Wipe Edit can be set up by clicking the gray bar.  Moreover, adjustment of Wipe 

Timing can be also done by dragging the gray bar. 

 

Display of 

Timebase 

The horizontal direction of the window indicates Timebase showing the 

duration time from the beginning of the contents.  

Timebase has two forms: [Time Signature Display] and [Actual Time 
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Display].  To switch the display form, select [View]  [Display Timebase] 

from the menu.  Just after opening the [Wipe Edit] dialog, the same 

Timebase as the Main Window is displayed. 

How to edit Wipe 1. Setup Wipe Timing Flag. 

Click the text of Event Bar or select [Set All] / [Set at Both Ends] from 

the [Flag] menu.  A red flag mark is indicated on the selected 

Event(s).  In order to cancel any flag, click the text again or select 

[Cancel All] from the [Flag] menu. 

2. Play Music. 

Select [Play] from the [Emulator] menu or click [Play] on the Tool Bar. 

Playback Start Time can be designated by choosing [Forward] or 

[Rewind] button before starting. 

3. Input the Wipe Timing. 

Press a space key when the replay point of music comes to the 

flagged position.  Then Wipe Timing for the music and the Event are 

adjusted, and a flag color changes to blue.  After the last input of the 

Wipe Timing has been completed, press the space key again so that a 

replay is terminated at that point.  A replay is also terminated 

automatically after 10 seconds. 

4. Reflect the specified Wipe Timing. 

After a replay is terminated, the SCAS confirmation dialog appears. 

If clicking [Yes], the designated Wipe Timing will be reflected in.  At 

this time, the Wipe Timing of each Event is fine-tuned by a linear 

interpolation; therefore, Wipe can be executed more naturally. 

Select [No] if you do not want to reflect any designated modification.

 

If the number of flags and pressing the key are not matched, the replay 

continues until exceeding the last Event display time.  In order to stop 

editing during the replay, select [Stop] from the [Emulator] menu or click 

[Stop] on the Tool Bar.  In this case, any designated modification is not 

reflected in. 

Fine Tuning of 

Wipe Timing 

The Fine tuning of the Wipe Timing can be performed by left-clicking and 

dragging the Event Bar Text.  This function is useful when the timing was 

entered by mistake.  For example, after entering the Wipe Timing to 3 

different designated flags, (you realized…) “the initially entered Wipe 

Timing to these flags needs to be changed into a bit of earlier position…”  

With remaining these flags selected and by dragging only the very first 

Event, its Event Wipe Timing can be adjusted.  Along with the first Event 

adjustment, the last flagged Event is automatically fine-tuned. 
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(* Operation of interpolation may be different depending upon the Event 

Display Time or Flag Setup Status.) 

Change Wipe 

Timing 

The Wipe Timing of only an arbitrary Event can be modified by 

left-clicking and dragging the wipe mark on the Event Bar. 
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5.2. List Edit 
All Events included in the contents are listed in order of the display time.  Any display overlapped 

section can be seen easily by the Condition Display, and also the Display Time and Lifetime can be 

modified in this window. 

To open this window, select [Tool]  [List Edit] from the menu. 

 
 

Changing Display 

Time 

A cell becomes an edit mode by choosing a Display Time cell to be 

modified first, and then double-clicking it or going to [Edit]  [Change 

Time].  It can be modified by clicking the spin-buttons or just entering 

the value by using the key board. 

However, the value can be changed only within the range of the Display 

Time of Events located before and after.  

Changing Lifetime A cell becomes an edit mode by choosing a Lifetime cell to be modified 

first and then double-clicking it or going to [Edit]  [Change Time].  It 

can be modified by clicking the spin-buttons or just entering the value by 

using the key board. 

Displaying Wipe 

Time 

The Wipe Time is displayed only for the Event when its Wipe effect is 

enabled.  Its value can not be changed in this window. 

Display Condition ×: Either the Display Time or Display Location is overlapped on the same 

Plane (applied to all Events). 

△: The Wipe Time is less than 2000msec. 

○: There is no problem with the Display Overlap and Wipe Time. 
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Moving Event 

forward and 

backward 

The Event order can be shifted forward and backward by selecting the 

Event to be shifted and then going to [Edit]  [Move Forward]/[Move 

Backward] or clicking the forward/backward arrow button on the Tool Bar.  

However, this shifting process can be done within the same Block and 

between the Events with the same Display Time.  Since each Event is 

guaranteed to be played in the list order, when the different Events have 

the same Display Time and Display Location, the one which has been 

listed in the lower column is displayed over the Event listed higher in the 

Page Edit Window and Replay Window. 

Display / 

Un-display of 

Event 

classification 

By each Event Display button on the Tool Bar, the display/un-display 

status of each type of the Event can be switched.  The [All] button allows 

all the Events to display/un-display all types of the Events.  In addition, 

these Events type can be also switched (display/undisplay) by going to 

the [View] menu. 
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5.3. Graphics Track List Edit 
 

All information about the Block and Event included in the contents are listed.  They are listed ｂｙ the  

Display Time order.  Also all attribute and effect information are displayed.  In other words, all items 

included in the Event Setup dialog can be referred in a view format.  Each item can be modified in 

this dialog, and also its attribute can be copied and pasted. 

To open this window, select [Tool]  [Graphics Track List Edit] from the menu or click the [Graphics 

Track List Edit] button from the menu of the Main Window. 

 

 

Change Attribute First, select a cell to be changed.  The selected cell can become an edit 

mode by pressing the [Enter] key on the key board, double-clicking the cell, 

going to the [Item Attribute] button, or selecting [Event]  [Item Attribute] 

from the menu.  The Edit mode can be different depending upon each item 

as follows.  The modified value will be reflected in after the [Enter] key is 

pressed or another cell is clicked. 

Input text Text/Bitmap Text Event...the Text box is displayed.  

Text Block Event...the Text Block Input window is 

displayed. 

Input value The Spin-buttons are displayed.   

Designate Image/Image Tile Event...the Image Designation dialog is 
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image displayed.  

Bitmap/Bitmap Tile Event...the Bitmap Designation 

window is displayed. 

Designate 

color 

The Color Designation dialog is displayed. 

Sequence 

information

Wipe Sequence...the Wipe Information Setup window is 

displayed.  

Move...the Move Sequence Setup window is displayed.  

Combo box The pull-down menu of selectable items is displayed. 

Designate 

enable / 

disable 

Enabling/disabling of the check box is switched. (* no edit 

mode existed)  

When in "Enabled", the details about its attribute are 

displayed, and it becomes editable. 

When in "Disabled", the details about its attribute are 

displayed with a gray shade, and it becomes not editable.
 

* Display Time Note: the basic time location of Display Time differs between the Block and 

Event. 

Block Display Time from the beginning of the contents. 

When the order of Display Time has been changed, its 

display order in each Block (including any related Event) 

will be changed as well.  

Event Display Time from the beginning of the Block.  

When the order of Display Time has been changed, the 

display order of the Event will be changed as well. 
 

* Lifetime Lifetime of a Block can not be edited.  It is automatically calculated by 

Display Time and Lifetime of the Event which have been included in the 

Block. 

* Display of Event 

Setup dialog 

The [Text Event] dialog is displayed by selecting the desired arbitrary Event 

line, and then clicking the [Attribute] button or selecting [Edit]  [Attribute] 

from the menu. 

Copy & Paste The value of each item can be copied and pasted.  First, select a cell to be 

copied from, then click the [Copy] button or select [Edit]  [Copy].  Then, 

select a cell of a destination, and click the [Paste] button or select [Edit]  

[Paste].  The value in the cell (to be copied) will be pasted into the other 

desired cell.  However, only the same format of the value can be pasted.  If 

so, pasting it into different item can be executed. 

Multiple items can be selected by clicking desired items with the [Ctrl] key 

pressed.  Moreover, the one-line selection of the lists can be done by 

clicking the list title.  Under this state, the value of the item already copied 
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can be pasted. 

Display/Un-display 

of Event 

Switching display/un-display per Event type can be done by each Event 

display button on the Tool Bar.  The [All] button can display/un-display all 

the Events on the Tool Bar.  In addition, selecting an item from [View]  

[Event] also enables to switch its display/un-display status. 

Display/Un-display 

of Attribute 

Switching display / un-display per Attribute type can be done by each 

Attribute display button on the Tool Bar.  In addition, selecting an item from 

[View] -> [Attribute] also enables to switch its display/un-display status. 

 

 

5.3.1. Editing Multiple Events Simultaneously 
The attributes for multiple Events can be edited simultaneously.  Select two or more arbitrary Events, 

then click the [Attribute] button on the Tool Bar or select [Event]  [Attribute] from the menu.  The 

[Multiple Events] dialog is displayed.  The Attribute tabs differ in the type of the selected Event, and 

only the necessary attributes can be displayed.  The following picture shows the [Multiple Events] 

dialog as an example when all the Events are selected. 

 
 

The changes are reflected in to all selected Events after setting an arbitrary item and then clicking 

[OK].  However, the changes are not reflected into the Event and Block which do not have its target 

attribute. 
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The color attribute and image designation are reflected in only when the check box is checked. 

The check box of Enable/Disable changes from ON  grayed display  OFF.  ON and OFF are 

reflected in as Enabled and Disabled respectively; therefore, when you don't want to reflect any 

change, switch it to the grayed display.  

 

 

5.3.2. Search Functions 
The only Event according with the condition of the search value is displayed by choosing the desired 

search item (left column) and entering the desired search value (right column). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Designate the item to search

2. Events which match the 
words are extracted. 
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5.4. Duplication Check 
 

This function checks to see whether any Text Display of the Graphics Track overlaps with others on 

the screen and the Timebase.  This is applied only for a Text Event and a Text..  It does so 

regardless of the display plane.  

Select the Graphics Track Window and then select [Duplication Check] from the [Tool] menu in the 

Main Window.  The [Duplication Check] dialog opens, and its results are shown. . However, this 

function can be done only when two or more Blocks exist in the Graphics Track Window. 

The Block Edit Window can be also opened from this window.  Select one of the overlapped results, 

and then double-click it or click the [Block Edit] button.  The [Block Edit] window of the selected 

Block will appear on the left side. 

 

 

Check Start button Checking any duplicated text is started and its results are displayed. 

Block Edit button The Block Edit window with duplicated Events is displayed.  

Close button This dialog is closed. 
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5.5. Block List 
 

Any Blocks created in the Graphics Track Window are listed.  Select the Graphics Track Window, then 

go to [Block List…] from the [Tool] menu in the Main Window.  The [Block List] window opens. 

 
 

Block Edit The [Block Edit] window opens and the selected Block is displayed by 

selecting an arbitrary block, then double-clicking it or selecting [Edit]  

[Block Edit] form the menu. 

Change Display 

Magnification 

The Display Magnification of a Block can be changed by selecting one of 

[x0.5], [x1], or [x2] from [Magnification] under the [View] menu.  When 

the [Block List] Window is displayed initially, the [x1] Block is shown. 

 

 

5.6. Setting Contents Information 
 

With SCAS, it is necessary to set up the information of the contents to be created.  Set up the 

information by following the contents for the Carrier Specification.  The Contents Information dialog 

is displayed by selecting [Contents Info] from the [Edit] menu in the Main Window. 
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5.6.1. SMAF Information 

 

 

Contents Class This can not be changed.  The Contents class only for a Carrier is set up.  

Contents Type The contents type based on the Carrier specification is set up.  The list for the 

selectable contents type changes by the contents of the Score Track.  

Character 

Code 

This can not be changed.  The Character code only for the Carrier is set up. 

Copy Status Enabling and Disabling Edit, Save, and Transfer of the contents edited within a 

mobile terminal can be selected.  The items based on the Carrier specification 

is selected.  When using a “cas” file created by SCAS MA-2, selecting "edit" 

becomes an “editable” state..  

Song title The song title is entered.  

Artist’s name The artist name is entered.  

Words by The name of the writer is entered.  

Composed by The name of the composer is entered.  

Arranged by The name of the arranger is entered.  

Category 

name 

The category of the music (genre) is entered.  
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Vendor’s name The name of the vender who created the data is entered.  

Copyright(c) The information about copyright and intellectual property right is entered.  

Carrier’s name The information about a Carrier is entered.  

Copyright 

managed by 

The name of the manager is entered.  

Management 

information 

The management information is entered. 

 

 

5.6.2. Rendering Size 

 

 

Screen Rendering 

Size/File Output RS 

Tag 

Usually the same value as File Output RS Tag should be selected. 

If intended to select a different value, please refer to “Chapter8----- 

1.2.2 How to Use Screen Rendering and File Output RS Tag”. 

*The rendering size which has been set up here is reflected in the display of the Page 
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Edit Window, the Block Edit Window, and the Block List window. 

 

 

5.6.3. Origin Designation 

 

 

Origin 

Designation 

The status （Enable/Disable） of Origin Designation is selected.  

X-coordinate / 

Y-coordinate 

The value and coordinate system of X-coordinate and Y-coordinate are 

selected.  An input range is from -2048 to 2047 for [X] and [Y] in the 

Standard and the Symmetrical Coordinate System, whereas from 0 to 127 for 

[X] and [Y] in the Layout Coordinate System.  

Width / Height The values for width and height are selected.  A selectable range is between 

1 and 2047.  

Reset button The origin designation id matched automatically to the output RS tag of the 

current file.  

 

*The Origin Designation is the function to designate a certain area by the absolute coordinate, 
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regardless of the LCD size.  This is the supplemental function to create the general contents 

regardless of the LCD size.  For more details, please refer to “5.7.3 Coordinate”. 

 

*If enabling the origin designation function, the location relationship of the solid-lined area for the 

screen rendering size and the broken-lined area for the file output RS tag in the Page Edit Window 

may be different by the coordinate system of the origin designation. 

 

 

5.6.4. Terminal Information 

 

 

Available 

Memory 

This is the available memory size which can be used by an actual mobile 

phone.  It is reflected in to the Memory Usage Display Window.  When 

designating a fixed mode, the memory size which can be used in the actual 

mobile phone is set up.  When designating a variable mode, the memory 

size to be used in SCAS can be designated.  An input range is from 0 to 

214748347.  

Max image 

sizes 

The maximum image size to be imported is restricted.  An input range is 

from 0 to 32767 for both [Width] and [Height]. 
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5.7. Coordinate Designation 
 

When replaying with the mobile phones having a different LCD screen size, the display position may 

differ depending on definitions. 

The designating method for the coordinate position is explained as follows. (Please refer to a sample 

file in “Chapter 9 ----- Samples”). 

 

5.7.1. Methods of Designating a Coordinate Position 
A display position of each Event can be designated by one of the three coordinate systems; 

Standard Coordinate System, Symmetrical Coordinate System, and Layout Coordinate 

System.  With the Standard and Symmetrical Coordinate Systems, the position is designated by 

pixel, but with the Layout Coordinate System is designated by a ratio of the screen size.  The 

Coordinate System can be designated for each X and Y independently. 

 

5.7.2. Display Difference 
 Standard Coordinate System 

The X and Y directions are designated from the left top corner in the LCD as an origin.  The displayed 

contents tend to lean towards the left top corner in a mobile terminal with a bigger screen size.  

Therefore, some objects (such as banners) appearing from the outside screen can be seen at the 

beginning of starting playback. 

Terminal A: 96 x 104 

 

Terminal B: 120 x 117 
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 Symmetrical Coordinate System 
The X and Y directions are designated from the right bottom corner in the LCD as an origin.  The 

displayed contents tend to lean towards the right bottom corner in a mobile terminal with a bigger 

screen size. 

Terminal A: 96 x 104 

 

Terminal B: 120 x 117 

 
 

 

 Layout Coordinate System 
Since the position is designated by a ratio of the screen size, the Event location does not change 

regardless of the screen size.  However, the interval of each Event may be too large in a mobile 

terminal with a bigger screen size. 

Terminal A: 96 x 104 

 

Terminal B: 120 x 117 
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In addition, Events overlapping may change depending on the screen size. 

 

Terminal A: 96 x 104 

 

Terminal B: 120 x 117 

 

 

Please create the contents by considering aforementioned precautions.  Some of these problems can 

be solved by designating an X direction and a Y direction individually. 
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5.7.3. Coordinate Origin Move 
 

Although the contents for efficiently using the display area can be created by using the Layout 

Coordinate System, the Origin Move function is available for controlling the absolute location selection 

to the LCD screen size like the above example..  For example, set up a smaller screen by selecting a 

larger screen size. 

In the following example, set a 96 x 104 rectangle (a smaller screen) in a 120 x 117 terminal, and it is 

centered. (Please refer to a sample file in “Chapter 9 ----- Samples”.) 

 

 

When opening a Block in a 120 x 117 screen terminal, a 96 x 104 black-lined rectangle will be 

displayed.  This rectangle becomes a new origin.  Absolute location selection can be performed by 

arranging display objects with the Standard Coordinate System and the Symmetrical Coordinate 

System regardless of the screen size.   

However, any graphics object designated by the Layout Coordinate System is not influenced by this 

origin.  It is displayed in the location calculated from the displayed terminal size. 
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Terminal A: 96 x 104 

 

Terminal B: 120 x 117 

 

 

5.8. XF Import 
 

The XF file (*.mid) which is used in the application such as a KARAKU and the XKM file (*.xkm) can 

be used as the lyric data. 

 

5.8.1. XF Import Outline 
When importing an XF file, a new Graphics Track is generated.  Furthermore, new Blocks and Events 

are generated by following the below descriptions. 

 

5.8.1.1. Contents Title 
A Title Block is created at the beginning of the contents.  The Text Event for displaying a music title 

and an artist name is also generated.  A music title and an artist name are referred to those defined 

in the XF information header of the XFIH chunk. 

 

5.8.1.2. Generating a Block / an Event 
When a line-feed is defined in the lyric data, a new Text Event (with the subsequent lyric data) will be 

created in a different Block.  

For a section of VocalPartCue in the XFKM is considered as a Block, the Text Event is created.  Even 

in the middle of the section of VocalPartCue, when a line-feed is defined in the lyric data, the 

subsequent lyric data is created in a different Block.  Any Text Events created within the same Block 

is set up at the same display time. 

 

The Text Events is generated as one Event to the nearest line-feed code in the lyric data. 

The Text Event in the Block is automatically laid out when imported. 

The X-coordinate is set up from the top of the screen in the order of [Align Left] and [Align Right].  
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In this case, when the number of lines is the odd one, the very last line is centered.  The 

Y-coordinate is set up under [Align Bottom].  

When the width of a certain line for the lyric data is wider than that of the display area, a linefeed is 

performed as a section of the Event in the XF data.  In this case, any string line (Text Events) after 

the linefeed code is aligned to the right. 

 

The Wipe information for the Text Event is set up automatically based on the Wipe timing of the XF 

lyric Event. (in the above sentence, the “Wipe timing” refers to the wipe process timing of the lyric 

display during XF playback which is calculated from the XF lyric Event timing information, the lyric 

display offset value of the XF lyrics header, or the start time measuring point defined in the cue data 

"START".) 

 

Any XF data definitions except for the above are handled as follows;.  

- Space designation '^' will be converted into a half-sized space (en quad). 

- Sub-linefeed '%' is handled as same as regular linefeed. 

- Tab designation '^' aligns the Text Event to the right after line designation. 

 

 

 Event Parameter Wipe Effect Wipe Sequence Effect 

Music Title, Player, 

except Lyric 

40h Not set up Not set up 

Solo 41h 

Male voice 42h 

Female voice 43h 

Mixed voice 44h 

Set up 

Chorus 45h 

Set up 

Lyrics (Words) 46h Not set up 

Not set up 

 

5.8.2. Setting the Color Attribute and Coordinate System 
When importing an XF file, the Event Parameter can be automatically set up to each Text Event.  

SCAS sets up the Event Parameters like the above table by the VocalPartCue definition of the XFKM 

chunk.  

The Event setting after importing can be omitted if the color attribute per Event Parameter (the color 

for the text, the background, and the transparency process before and after Wipe) or the Coordinate 

System are set up before importing the XF file. 

In addition, the display plane of all Text Events is set in Plane2. 
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5.8.3. Setting the Wipe Attribute 
By designating [Import As Wipe Sequence] when importing the XF file, a Wipe effect added to the 

Text Event can be switched. 

If selecting [Import As Wipe Sequence], a Wipe Sequence effect will be added.  At this the Wipe 

information of the Text Event is reflected by referring to each Wipe timing of the lyric Event. 

If not selecting [Import As Wipe Sequence], a Wipe Effect will be added.  At this time, the Wipe 

information of the Text Event is reflected by referring to the wipe timing only for the lyric Event which 

corresponds to the first letter in the Text Event. 

Regardless of selecting [Import As Wipe Sequence], a Wipe effect may not be added by the 

VocalPartCue definition. 

Please refer to the above table. 

 

Please refer to “3. Editing the Event” for further information about fine adjustment of the wipe 

attribute which has been automatically set up by an XF import. 

 

5.8.4. Importing Contents Information 
If selecting [Import contents information also] when importing an XF file, the contents information 

can be loaded on SCAS by referring to the XF information header of the XFIH chunk. 

The importable items are the Music title, Artist, Lyricist, Composer, and Arranger. 

In addition, a category will be initialized when designating [Import contents information also]. 

 

5.8.5. Designating the Lyric Indication Offset Value 
When importing an XF file, the offset value of the lyric display can be designated arbitrarily into the 

arbitrary point by checking [Lyrics offset value].  The offset value can be expressed as either .msec 

or .tick. 

 

5.8.6. Designating Clearing Information at the Time of Import   
When importing an XF file, the graphic track information can be maintained by unchecking the 

checkbox of [Clear play tracks before import].  With the initial setting, all the information will be 

cleared. 

 

5.8.7. Restrictions 
SCAS terminates the importing process of an XF file under one of the following conditions: 

- The SMF format is not 0. (A file format is other than an XF).  

- The tempo information is not defined in the SMF Track Chunk.  

- The music title is not defined in the XF information header of the XFIH chunk.  

- An XFKM chunk does not exist.  Or an error has occurred when loading a XFKM chunk. 

- The Lyric data is not defined in the XFKM chunk. 

 



 121

 

Chapter 6 -----  Editing the Score Track 
 

In SCAS, a part of the Score Track function can be created by importing ｔｈe music data or adding the 

HV-Script/Audio data as an Event.  Music data formats that can be imported are MA1, MA2, MA3, 

MA5, and MA7.  Score Track Information Pane and Score Track Edit Pane in Main Window can be 

used for editing the Score Track.. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are three areas in the Score Track Information Pane: the Play Information Display Area, the 

Score Track Channel Display Area, and the Compressed Audio Channel Display Area.  By 

double-clicking either the Play Information Display Area, each corresponding dialog box will be 

displayed.  In order to open the [Play Information Setting Dialog] box (for modifying the PeakGain 

values, the Start Time Delay values, and the Vib or LED On/Off status), double-click the Play 

Information Display Area.   

Score Track 
Information 

Pane 

Score Track 
Edit Pane
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1. Play Information Dialog 
The modifications for the PeakGain value, the Start Time Delay value, and the Vib or LED On/Off 

status can be specified. 

 

 

 

Peak Gain The play volume for the Score Track on a scale of -12 to 0. 

Vib. The Vib On/Off status can be modified in each channel by double-clicking 

an item (cell) to be modified. 

LED The LED On/OFF status can be modified by each channel by 

double-clicking an item (cell) to be modified.  

 

Play Information Display Area 

Score Track Channel Display Area 
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2. Mixer Dialog 
A dialog box for executing each channel setup. 

 

MSB/LSB/PCh The MSB/LSB/PCh values in each top-of-channel of the SMAF Score Track 

are displayed.  These cannot be edited. 

Pan Slider The Panpot values in each top-of-channel of the SMAF Score Track are 

selected in the range of 0 to 127. 

Send Area The DrySend (D), ReverbSend (R), and ChorusSend (C) values in each 

top-of-channel of the SMAF Score Track are selected with a button 

(whether being inserted or not).  When being inserted, each value is 

selected in the range of 0 to 127 by using a slider. 

Vol. Slider The channel volume values in each top-of-channel of the SMAF Score 

Track are selected in the range of 0 to 127.  A default value is 100.  

According to the audio channel, since this value becomes invalid, please 

select the volume value for each audio note. 
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Reverb Setting 

Parameter and 

Chorus Setting 

Parameter boxes 

They are located in the bottom of the dialog.  The default parameter 

value for the Reverb Setting or Chorus Setting is inserted.  If the 

parameter value has already been inserted into the imported SMAF, it 

cannot be edited.  In this case, it is displayed in a masked checked-box.

 

 

3. Setting Event Information 
The Event information created in the Score Track is set up with the dialog.  Although the 

modification of the Start time of pronunciation and the channel designation can be done by the Score 

Truck operation, in this dialog, HV Event setting can be done by checking the HV-Script.  The HV 

Event dialog can be also opened from the Score Truck Window.  Please chose a certain Event and 

double-click it or just click [Attribute] menu/button.  When a new Event is created, the [HV Event] 

dialog is displayed by default. 

 

3.1. Creating an Event by Dragging and Dropping 
By dragging and dropping an HV-Script file/ an audio file, the setting dialog to designate an Event 

type.  Here, by performing Event attribute and effect setups and then clicking the [OK] button, an 

Event can be created at the location of the [E] mark (Edit mark). 

 

<Reference： A type of Events created by dragging and dropping your desired file> 

Text File ※ Text Event 

Text Block Event 

Bitmap Text Event 

Image File ※ Image Event 

Image Tile Event 

Binary Bitmap File ※ Bitmap Event 

Bitmap Tile Event 

HV-Script File HV Event 

Audio File Audio Event 

*The Event is created on the Score Track Window although it can be dragged and dropped on the 

Graphics Track Edit Pane. 
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3.2. Setting the HV Note Event 

 

 

HV The HV-Script is designated.  

Channel A channel for HV Note On is designated.  

Pronunciation 

Start Time 

The time to start HV-Script pronunciation is designated.  A unit is 

millisecond.  An input range is from 0 to (2097151-Lifetime). 
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3.3. Setting the Audio Note Event 

 

 

Audio The Audio data is designated.  

Velocity slider The Audio Note volume is designated in the range of 0 to 127.  If no 

check mark in the box, the Audio Event will be replayed at the default 

volume value 100 or the previous note volume. 

Channel A channel for Audio Note On is designated.  

Pronunciation 

Start Time 

The time to start Audio pronunciation is designated.  A unit is 

millisecond.  An input range is from 0 to (2097151-Lifetime). 

Play button The Audio data is reviewed. 

Volume slider The listening volume is adjusted.  This value is not reflected upon SMAF.
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4. Registering the Play Data 
The HV-Script to create an HV Event must be registered beforehand. 

Also, the Audio data to create an Audio Note Event must be registered. 

 

4.1. HV Registration 
 

The HV-Script used in the Score Track Window is registered.  Select [HV-Script Registration…] from 

the [Tool] menu on the Main Window.  The [HV registration] dialog opens.  The file [Open] dialog 

appears by clicking the [Registration] button.  Select a HV-Script file to be used.  Multiple files can 

be registered at once. 

 
 

Registration 

button 

A new HV-Script is registered.  The file [Open] dialog appears.  Select 

an HV-Script file to be used. 

Replace button A registered HV-Script is replaced.  The file [Open] dialog appears by 

clicking the [Replace] button.  Select an HV-Script to be replaced. 

Export button A registered HV-Script to a file is output.  The [Save As] dialog opens by 

clicking the [Export] button.  Designate a file to be saved. 

Delete button A registered HV-Script is deleted.  Select an HV-Script and click [Delete]. 

The ［DEL］ key also can delete it.  

* It can not be deleted while the HV-Script is in use. 

Edit button The dialog is displayed to edit an HV-Script chosen on the list. 

Double-click the selected item to open an edit screen as well. 

New button The [HV-Script Edit] dialog is displayed to register a new script on the list. 

Double-click an empty space in the dialog to open the edit screen for 
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creating a new HV-Script. 

OK button / Cancel 

button 

OK:  Any changes are reflected in and the dialog box is closed. 

Cancel:  All changes are cancelled and the dialog box is closed. 

 

 

4.1.1. HV-Script Edit  
The HV-Script used in the Score Truck is edited.  According to the HV-Script format, please refer to a 

separate format guide. 

 
 

Height Accent Buttons Four types of high/low accent symbols are inserted in the HV-Script. 

Strength Accent 

Buttons 

Two types of strong/weak accent symbols are inserted in the HV-Script.

Accent Clear Buttons Three kinds of accent clear symbols (for the previous accent symbols) 

are inserted in the HV-Script. 

Rhythm of Clause 

Buttons 

Five kinds of rhythm symbols are inserted in the HV-Script. 

Control Character 

Buttons 

Five kinds of control character symbols are inserted in the HV-Script. 

Echo Button An echo symbol is inserted in the selected area of the HV-Script. 

HV-Script Name (Edit)  The HV-Script name is specified. 

Default Voice 

Combination Box 

At the beginning of the HV-Script, the voice quality symbols are inserted.  

A default voice is a normal male voice.   
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Optimize HV-Script 

Check Box 

When the “Optimize HV-Script” box is checked, the HV-Script format is 

optimized while replaying. 

Remain Linefeed 

Check Box 

When the “Remain Linefeed” box is checked, the linefeed is remained in 

optimization. 

Insert Segment End 

Check Box 

When the “Insert Segment End” box is checked, a segment end is 

inserted in optimization wherever needed.  

Long 

Vowel/Silent/Segment 

End Buttons 

Long Vowel/Silent/Segment End symbols are inserted in the HV-Script. 

Copyright Button A Copyright symbol (by checking the Save, Edit , or Trans checkbox) is 

inserted in the HV-Script. 

Replay/Stop Buttons The HV-Script is replayed and stopped. 

Volume Slider (MV) The Replay volume in the HV-Script is adjusted in the range of 0 to 127. 

Its default value is 100. 

Loop Replay Check Box When checking the “Loop” checkbox and then clicking the “Play” button, 

loop replay is executed. 

Open File Button The [Open] dialog is displayed to import the HV-Script. 

Save Button The [Save As] dialog is displayed to save the HV-Script file. 

OK/Cancel Buttons OK: Any changes are reflected and its dialog box is closed. 

Cancel: All changes are cancelled and its dialog box is closed. 
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4.2. Audio Registration 
The audio data used for the Score Track is registered.  Select [Tool]  [Audio Registration] from the 

menu in the Main Window.  The [Audio Registration] dialog opens.  When pressing a [Registration] 

button, the [Open] dialog box appears.  Choose an audio file to be used.  Audio Registration can be 

also done by dragging and dropping a file on to the dialog from Windows Explore.  More than one 

file can be registered at a time. 

 

 

Registration 

Button 

A new audio data is registered.  The [Open] dialog opens.  Select an 

audio file to be registered.  

Replace Button The registered audio data is replaced.  Choose an audio data on the list 

and press the [Replace] button.  The [Open] dialog will open.  Select an 

audio file to be replaced.  

Delete Button The registered audio data is deleted.  Choose an audio data on the list 

and press the [Delete] button.  A [Del] key can be used to delete the 

data as well. 

Edit Button The [Audio Information Edit] dialog is displayed in order to edit the audio 

data information selected on the list. By double-clicking the item to be 

selected also opens the same dialog. 

OK/Cancel Buttons OK: Any changes are reflected and the dialog box is closed. 
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Cancel: All changes are cancelled and the dialog box is closed. 

 

 

4.2.1. Audio Information Edit Dialog 
The registered audio data information is edited. 

 

 

Pan Check Box The Stream PCM Pan value of the Audio Data is specified whether needed 

inserting into SMAF.  The Pan box is normally checked with the 

masked-display (as to be inserted into SMAF all time).    

Pan Slider The Panpot values of Stream PCM Pan is modified in the range of 0 to 

127.  This can be only used when the Pan box is checked. 

Panpot/Clear/PanOFF 

Radio Buttons 

The Stream PCM Pan Event is selected whether the Panpot specification 

should be turned on, cleared, or turned off..  This can be only used when 

the Pan box is checked. 

OK/Cancel Buttons OK: Any changes are reflected and the dialog box is closed. 

Cancel: All changes are cancelled and the dialog box is closed. 
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Chapter 7 -----  Emulator Replay 
 

SCAS has the terminal emulator built-in; therefore, the performance of editing contents can be 

checked.  However, it is just an emulator per se.  Make sure to check with the actual terminal. 

 

1. Setting Terminal Information 
 

Check the setting of terminal information before opening the Emulator Window. 

For more details about terminal information, please refer to “3 Terminal Information”.  For a 

complete explanation about a setup of terminal information, please also refer to “Chapter 8 ----- 1.8.2 

Setup method of terminal information dialog”. 

 

2. Emulator Window Dialog 
 

2.1. Window Display 
There are three kinds of methods to display the Emulator Window dialog as follows: 

 

1. A list of the terminal information file which already has been saved/set is displayed in a Terminal 

List of the [Emulator] menu in the Main Window.  In this terminal list, the toggle switch of the 

status (display/un-display) for the Emulator Window of the selected terminal is performed.  The 

Window-displayed terminal is shown with a check-mark.  

2. Select [Emulator Window….] from the [Emulator] menu to open the [Emulator Window] dialog.  

Here, a list of the already set/saved Terminal Information file is displayed here.  Select a desired 

terminal name and then click the [Open] button to open the Emulator window.  

3. By clicking the [Open And Close Emulator] button on the tool bar, the status (display/un-display) 

of the terminal selected in the [Emulator window] display is switched. 
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*When clicking the column titled “Terminal Name”, the Terminal Information list can be sorted by 

“Terminal Name” or “Update Time” in either an ascending or a descending order. 

 

2.2. Display Magnification and Screen Update Interval 
 

 

 

An Emulator Window can be changed its magnification in the range of [x1] to [x4].  Select [Display 

Size] from the [View] menu or click one of the magnification buttons on the Tool bar. 

 

When replaying on the emulator, the interval for the screen update is carried out every 100msec. 

Therefore, when using a mobile phone whose screen update interval exceeds 100msec, the 

performance may not be displayed as intended 

 



 134

 

2.3. Emulator Replay 
 

In order to replay with the emulator, use Emulator buttons on the Tool Bar in the Main Window or 

select an item of the [Emulator] menu.  It is also possible to operate the Emulator by the keyboard.. 

 

 

Play In order to start playing, select [Emulator]  [Play] in the Main Window or click 

the [Play] button on the Play Bar.  Once replay gets started, the contents of 

Graphics Track are displayed in the Emulator Window as progressed.  When the 

music data exist, the sound is also output.  The playing point ([P]) on Timebase 

in the Main Window moves along with the counter in the Play bar.  When the 

playing point runs off the screen, the screen scrolls automatically and always 

displays the Graphics Track and Score Track at the playing point.  When the 

playing point comes to the longer sequence data in either the Graphics Track or 

Score Track, the performance is automatically terminated. 

Stop When clicking the "Stop" menu/button during playing, pausing, or stopping, the 

replay is terminated.  The playing point ([P]) and the counter will return to the 
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beginning ("0:00:00" / "1:1"). 

Pause The [Pause] menu/button is available only during playing.  Clicking the [Pause] 

button makes the Event stop.  The playing point ([P]) and the counter also stop 

where the Event was stopped..  Click the [Play] button to resume the Event 

from the paused point.  If selecting the [Stop] button here, the pausing status 

will be canceled.  The playing point and the counter will return to the 

beginning. 

Forward / 

Rewind 

The Replay Start Point can be modified during stopping or pausing.  By 

executing the [Forward] or [Rewind] menu/button, the playing point ([P]) can 

be brought forward or back.  At the same time, the counter also counts up or 

down.  When clicking the [Play] button, the Event gets resumed at the playing 

point ([P]). 

Forward 

100ms / 

Rewind 

100ms 

The Replay Start Point can be modified during stopping or pausing.  By 

executing the [Forward] or [Rewind] menu/button, the playing point ([P]) can 

be brought forward or back per 100ms.  At the same time, the counter also 

counts up or down.  When clicking the [Play] button, the Event gets resumed at 

the playing point ([P]). 

* These are not available when "Time Signature Display" of Display Timebase is 

selected. 

Move Replay 

Point 

In order to move the playing point ([P]) at once, left-click the mouse cursor on 

Timebase.  The ([P]) mark will move to the point of clicking.  The ([P]) mark 

while stopping means the Replay Start Position with Emulator Replay.  Starting 

from the arbitrary position can be executed by moving this point.  However, it 

can not be moved during playing. 

Replay 

Operation by 

Keyboard 

[F12], [SPACE], and ten-keys allows replay operation with the Emulator. 

[F12]: The Emulator Window is opened or closed.  

[SPACE]: The status (start/pause) of replay is switched. 

[ENTER]: Event replay gets started. 

[2]: Event replay is paused.  

[0]: Event replay is stopped and returned to the beginning. 

[1]: Event is rewinded to the beginning. 

[4]: Event rewinded for 1000msec.  

[5]: Event rewinded for 100msec.  

* Not available when selecting [Time Signature Display]. 

[6]: Event forwarded for 100 msec.  

* Not available when selecting [Time Signature Display]. 

[+]: Event forwarded for 100msec. 
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2.4. MIDI Time Code 
 

The MIDI Time Code output is set up. 

 

 

Offset MIDI Time Code 

Check Box  

Check the [Offset MIDI time code] box when outputting the MIDI 

time code during Emulator Replay.  

Device out Select the external device to be synchronized. 

Offset Set up the offset value.  Each maximum value is as follows; 12 

hours, 59 minutes, 59 seconds, and 28 frames. 
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3. Terminal Information 
 

The setting of Terminal Information is used for Emulator Replay.  Re-using the setting can be done 

by saving it into a file.  The [Terminal Information] dialog box is displayed by selecting [Terminal 

Info...] from the [Emulator] menu in the Main Window. 

 

3.1. Setup of Terminal Information 
 

3.1.1. Display Size 

 
 

Terminal 

Name 

The assumption terminal name is designated.  Multiple terminal information 

can be saved and then loaded.  It can be reflected in to the size of the Block 

Edit Window and the Emulator by inputting the difference of the screen size.  

Display Size The width and height of the terminal display are designated.  Multiple terminal 

screen sizes (saved as a file) can be used for checking the contents replay.  An 

input range is from 1 to 2047 for both the “Width” and the “Height”. 

Effective 

Display Area 

The area where SMAF drawing is performed during Emulator Replay is 

designated by a dot-size.  Also the standard location of the display area in the 

terminal LCD is selected.  An input range is from 0 to 255 for [Left end 

coordinate] and [Top end coordinate], whereas from 1 to 2047 for [Width] and 

[Height]. 
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3.1.2. Font 

 

 

Font The default font size is determined.  

The font size designated in this dialog will be referred as Width and Height of any 

font block for the Text and the Text Block Event in the SCAS Emulator Replay 

Window and the SMAF Player Window. 

* Please do not change the values without any special reasons. 
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3.1.3. Limitation 

 

 

Available 

Memory 

The memory size which can be used in a mobile phone.  The range is from 0 

to 21474834 bytes.  Click the [Set to contents information] button at the 

bottom of the dialog to reflect the value into the Contents Information dialog.

* Please do not change the value without any special reasons.  

Max Image 

Size 

The maximum image size to be loaded is restricted.  The range is from 0 to 

32767 for both [Width] and [Height].  Click the [Set to the contents 

information] button to reflect the value into the Contents Information dialog.

* Please do not change the values without any special reasons. 

 

 

3.2. Operation of Terminal Information 
 

Edit Terminal 
Information 

Select a desired terminal from the terminal list on the left-hand side of this dialog 

to edit Terminal Information.  The value is saved after clicking the [OK] button.

Add Terminal 
Information 

A new Terminal Information is added after editing the existing Terminal 

Information, and then clicking the [Save] button.  Place the Terminal 

Information file into the configuration directory.  After being added, make sure 

to click the [Cancel] button to close the dialog box to prevent that the existing 

terminal information from being overwritten. 

Replace 
Terminal 

The Terminal Information can be replaced by, clicking the [Load] button (to load a 

terminal setting file from other directory) with a desired terminal name on the 
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Information left-hand side of the terminal list selected. 

Sort the list of 
Terminal 
Information 

The Terminal Information list is sorted in the increase/decrease order for 

"Terminal Name" or "Update Time" by clicking the area where "Terminal Name" is 

written in the terminal list. 

Setup to 
Contents 
Information 

"Available Memory" and "Max Image Size" are copied into the contents 

information by clicking the [Set to contents information] button with a desired 

terminal name on the left-hand side of the terminal list selected. 

Specifically, it will be reflected as [Edit]  [Contents Info...]  [Terminal 

Information]. 
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Chapter 8 -----  When You Have any Trouble... 
 

If you have any trouble during SCAS operation and replay, please refer to this chapter. 

 

1. Create 
 

1.1. Loading a CAS File 
 

1.1.1. What's the SCAS file? 
The CAS file is a file for editing graphics of SMAF.  It can be operated only by the SCAS application.  

When creating a SMAF file, make sure to save the CAS file beforehand: therefore, its data can be 

re-edited later on.  

*SCAS can import the SMAF file.  However, only the music data can be imported. 

 

1.1.2. Notes on using SCAS for multiple specifications 
When using SCAS for multiple specifications, the CAS file should be used separately.  

If using a same CAS file for different specifications, the font information might be improperly 

executed. 

The version 2.x, 5.x, 6x, or 7.x must be used separately.  

 

 

 

 

 

 

 

 

1.1.3. Can not open the CAS file! 
[Phenomenon] 

The following message is displayed and the CAS file can not be opened. 

 

 

[Cause] 
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CAS itself has own file version.  The version of SCAS used currently may be older than the actual file 

version. 

 

[Response] 

Use the newest SCAS version to open the CAS file. 

 

 

1.2. Information Setup 
 

1.2.1. Setup methods of the contents information dialog 
Before creating a new CAS file, its rendering size and terminal restrictions must be set up in the 

[Contents Information] dialog. 

The setup procedures of the Contents Information dialog box are as follows; 

* When using the existing CAS file, reconfirm the [Contents Information] dialog after opening a CAS 

file.  

 

1. An effective display area of SMAF in a mobile phone has 120 dots in width and 130 dots in height. 

2. Select [Edit]  [Contents Information...] from the menu.  After the [Contents Information] 

dialog is displayed, choose the “Rendering Size” tab.  Enter 120 into "Width" and 130 into 

"Height" for both "Screen rendering size" and "File output RS tag" sections. 
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*Male sure to enter the same number for both "Rendering Size" and "File output RS tag”. 

 

3. Go to the “Terminal Information” tab and select "QQ-VGA (16bit color) fixed mode" for the 

"Available Memory" selection. 

4. A main setup has been done. 

 

1.2.2. What’s Timebase? 
- What's Timebase?  

Timebase is one of the data which is defined within a SMAF file and actually the smallest unit of the 

SMAF time-axis. 

 

- What kind of value should be set?  

For SCAS, it is recommended to set up 100msec in Timebase.  (Since the screen refresh cycle of a 

mobile phone is every 200 to 300 msec, its display appearance does not change even if the setting is 

a smaller value.) 

 

- Are there any notes? 

When setting a smaller value into Display Time or Lifetime of an Event in SCAS, it does not change 

anything.  (This is because time will be adjusted to the unit of Timebase inside the SMAF data.) 

 

For example, when editing a CAS file with its Timebase 100msec...  

Whether you put each rectangle event in every 10 msec (Display start time of A=10mse, B=20msec, 

and C=30msec) as the below figure; 

 

 

 

 

 

 

 

 

Events A, B, and C in the SMAF file generated by selecting [File]  [SMAF File] will be modified to 

start at "0" msec all together. 

* An image figure of the Event display start time in SMAF. 
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1.3. Restrictions 
 

1.3.1. Are there any restrictions when creating a new SMAF file? 
 

Restricted by Carriers 

The SMAF contents need to be created according to the restrictions which are defined by a Carrier. 

 

SMAF File Size 

SMAF-SCAS does not restrict its contents size.  When the SMAF data gets output, the file size is 

indicated.  However, the delivery restriction size should be confirmed by a user. 

 

Object Size  

SMAF-SCAS does not restrict its object size, but some terminals may be restricted.  

Any image, bitmap, or rectangle which is larger than the display area, or the bigger file size picture 

may not be displayed.  

 

Restricted by Terminal Memory Spec. 

This is the restriction part which can be set by selecting [Edit]  [Content Info...]  [Terminal 

Information] from the Main Window. 

 

Available memory: It is restricted.  This is the limited value of the “Static Memory Indicator” in the 

Memory Indicator Window. The red line indicates “exceeding the limit”.  The contents not to exceed 

this value must be created. 

 

Maximum width and height of a picture: It is restricted.  Even any sides of the picture can not be 

exceeded. 

A picture which exceeds the restricted size can not be imported. 

 

Restricted by Terminal Image Development Capability 

Image Development Capability restricts an available memory size.  It is the limited value of “Image 

Development Load Indicator” in the Memory Indicator Window.  The red line indicates “exceeding 

the limit”.  The contents not to exceed this value must be created. 

 

Since image development capability may change depending upon terminals, it is recommended to 

check the created SMAF file by playing on the actual mobile phone. 
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Restriction about XF import 

Please refer to “Chapter 4 ----- 3.1.2 Importing an XF file”. 

 

 

1.4. Basic Editing 
 

1.4.1. Can not create a new event! 
 

[Phenomenon] 

Can not create a new event. 

 

[Cause] 

An Event can be created only when a corresponding block is selected. 

 

[Response] 

1. When “Create Event” is not available... 

 

 

2. Select a Block 

 

 

3. Now “Create Event” is available. 

 

 

 

1.4.2. Display of a text block is not correct! 
 

[Phenomenon] 

When creating a text block, a white aree (extra space) is displayed.. 
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[Cause] 

Text block Event has a concept of “Block Backdrop Color”. 

 

[Response] 

1. The Block backdrop color can be invisible by setting the color to a “transparent color”. 

 

2. A white part became transparent. 
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1.4.3. What does it mean: "Change event attributes from parameter"? 
 

[Phenomenon] 

When changing a parameter during editing an Event, a message dialog, which says "Change event 

attribute from parameter. Change OK?” is displayed.  After clicking "Yes", the display position and its 

color of the Event have been changed. 
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[Cause] 

When clicking "Yes", the event information will be changed according to the parameter setting in 

[Edit]-[Track Information]. 

 
 

[Response] 

When you are not sure about this, click "No".. 

For more details about the parameter, please refer to "1.4.4 What’s parameter?". 
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1.4.4. What’s parameter? 
 

For the description about a parameter, please refer to "Chapter 2 ----- 5 Graphic Event and Parameter 

Designation”. 

It is useful to create parameters by use beforehand.. 

An example of creating events by using parameters is described below. 

 

1. Set up a parameter by selecting [Edit]  [Graphics Track Information…] 

 

 

2. An event is created with parameter 40h. 
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3. Change the parameter in the Text Event dialog. 

 

 

4. Click [Yes]. 

 

 

5. Now, the coordinate system and the text color have been changed according to the parameter 

setting. 

 
 

 

1.4.5. Input Text 
Any input for a Vertical direction and the Edge color cannot be executed. 
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1.4.6. Order of display in case of events overlap 
 

For more details for displaying the order when events are overlapped, refer to “Chapter 2 ----- 3. 

Concept of Plane in SMAF”.  Here, the SCAS setting is explained. 

 

1. For the events on Plane1 and Plane2, the one on Plane2 is displayed over Plane1. 

In SCAS, each Plane can be set up in the Event dialog. 

 

 

 

 

2．When the events are on the same plane in a different start time, the one in which Play 

Start Time is located later is displayed over the other. 

 

Play Start Time of an event is set up in the Time Edit Window. 
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3．When the events are on the same plane and start at the same time, the one added 

later is displayed over the other. 

  

 

 

1.4.7. Notes for the transparent color setting 
When setting a transparent color, select a desired color from the palettes of eight colors at the left 

side of the “Backdrop Color” dialog. 

 

 

 

1.5. Input from a Keyboard 
 

1.5.1. Emulator replay using a keyboard 
Emulator replay can be executed by using the keyboard. 
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1.5.2. Editing an event in the Block Edit Window by using a keyboard 
An Event edit can be executed by using the keyboard. 

A key assignment in the Page Edit pane is described in “Chapter 5 ----- 2.2.4.3 Page Edit Operation by 

a Keyboard”.  A key assignment in the Time Edit pane is described in “Chapter 5 ----- 2.3.7 Time Edit 

Operation by a Keyboard”. 
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1.6. Importing Pictures (Images) 
 

1.6.1. A JPEG can not be loaded! 
 

[Phenomenon] 

A JPEG can not be registered, and the following messages are displayed. 

 

 

[Cause] 

A picture file may be broken, or it may be a progressive JPEG. 

 

[Response] 

Please check whether an image file is neither broken nor a progressive JPEG. 

 

 

1.6.2. PNG Color is not correct! 
 

[Phenomenon] 

The color of the registered PNG is not correct. 

 

[Cause] 

The color of the PNG file is reduced into 256 colors. 

 

[Response] 

Since the applicable color is 256 colors, it is recommended to reduce the color to 256 colors by using 

an image edit tool before registering in SCAS.  When reducing the color, use the color palette which 

has the same color variation as SCAS does. （smaf_8bit_palette.act ： adobe Photoshop Color Table 

Format） 
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1.6.3. What kind of image can be used? 
Please refer to “Chapter 1 ----- 2 Specifications” and “Chapter 1 ----- 1 Operating Environment”. 

For the PNG file, the Type2 Index color is recommended to use. (For any PNG except forType3, a 

notice is displayed.) 

In addition, any PNG with a transparent setting or α-channels may not be displayed.  It is better 

not to use these PNGs. 
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1.6.4. Are there any restrictions for a JPEG compression ratio? 
Although the JPEG compression rate is not restricted, it is better to compress a JPEG with a high 

compression rate as long as its appearance does not get worse because the data size becomes 

smaller. 

 

Compression rate is low  

Data size is 23kBytes 

Data size is too big 

Compression rate is standard 

Data size is 4kBytes  

Though data size is small 

enough, its appearance does 

not change.  

Compression rate is high 

Data size is 2kBytes 

Its appearance is not clear 

and vivid. 

   

 

 

1.7. Operate Events Collectively 
 

1.7.1. Collective operation by using the Graphics Track List Edit Window 
Collective operation by using the Graphics Track Edit Window is very useful. 

 

When changing the value of multiple events collectively, it would be better to do this in the Graphics 

Track Edit Window. 

The value can be changed directly without opening the Event Setup dialog.  Moreover, the value can 

be edited collectively by using a copy & paste function. 

 

For more details regarding the Graphics Track Edit Window, please refer to “Chapter 5 ----- 5.3 

Graphics Track List Edit”. 

 

 

1.8. Emulator Replay 
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1.8.1. Preparing for emulator replay 
It is necessary to prepare the followings before starting emulator replay; 

1. Setup "Terminal Information" in the Terminal Information dialog. 

2. Select a terminal from the [Emulator] menu, and then open the Emulator Window. 

3. Click a [PLAY] icon so that emulator replay gets started. 

 

For more details, please refer to “Chapter 7 -----  Emulator Replay”. 

 

1.8.2. Setup method of terminal information dialog 
It is necessary to setup the terminal information in the Terminal Information dialog before starting 

emulator replay.  Here is the setup method.  Please confirm the effective display area for SMAF in a 

mobile terminal at YAMAHA SMAF GLOBAL(http://smaf-yamaha.com/). 

 

The effective display area of SMAF in a mobile phone is around width 120 dots x height 130 dots.   

Select [Emulator]  [Terminal Information] from the menu.  Then, enter 120 into "Width" and 130 

into "Height" for "Effective Display Area" and “Default Effective Display Area" respectively.  You may 

enter the arbitrary value into the other column. 

*Enter the same value into both "Rendering Size" and "File output RS tag". 

 

Now explains where the setup value will be reflected by using a illustration. 

The red frame area is the effective display area. And the area framed in blue is a display size. 

 

Leave the default value for "Font Size", "Available Memory" and "Maximum Image Size", if anything 

not specified.  . 

- Font size width = 12, height = 13 

- Available Memory = QQ-VGA(16bit color) Fixed mode 

- Maximum image size width = 640, height = 480 
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When the value has been entered, click the [Save] button to save the setup terminal. 

* Be sure to save in the "conf" directory. 

 

Now, setup has been done. 

 

1.8.3. Some events are not displayed during emulator replay! 
 

[Phenomenon] 

There are some events which are not displayed when replaying. 

 

[Cause] 

There are several causes to be considered. 

- Emulator setting is not correct. 

- The limit for the maximum number of simultaneous display (16) and/or simultaneous expression 

(16) is exceeded.  

- The memory limit is exceeded. 

- Image development loading capability is exceeded. 

 

[Response] 

There are four check-points. 

Confirm each point to figure out the problem. 

 

1．Is the setting of terminal information correct? 

Select [Emulator]  [Terminal Information] from the menu to open the [Terminal Information] dialog, 

and then check each setting under "Display Size," "Font," and "Limitation" tags.  For more details of 

the terminal information setting, please refer to “Yamaha SMAF GLOBAL (http://smaf-yamaha.com/)”. 
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2 ． At the incorrect display point, isn't the number of simultaneous display or 

simultaneous expression exceeding the maximum number of 16 ? 

Adjust an Event not to exceed the restriction number of 16. 

 

What's the number of simultaneous display 16, or the number of simultaneous 

expression 16? 

Event and modification information’s which are displayed at a time have upper limit. 

 

- Simultaneous display 16 = The maximum number of an Event to is limited to 16 (the simultaneous 

existence number of texts and images, etc.) 

- Simultaneous expression 16 = The maximum number of modification information is limited to 16. 

(the simultaneous existence number of effects on wipe, move, etc.) 

 

Object events and modification information are counted separately.  The maximum number of each 

is 16. 

Now these are explained by some examples. 

 

An example for the restriction of the simultaneous display number 16 

Even if there are 17 events...   An Emulator displays only 16 events.  

This is the restriction of simultaneous display 

number 16. 
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An example for the restriction of the simultaneous expression number 16 

The method of counting modification information is explained. 

 

There are two events in the left figure.  

1. Text: Banner, Move  

2. Bitmap: Banner, Move, Color Blink 

When all the above events exist at the certain time, the 

number of objects is 2, and the number of modification 

information is 5. 

 

When the number of modification information exceeds 16, an event which has the 17th modification 

information is not displayed. 

Even though 17 modification 

information’s are defined in 

SCAS... 

Emulator does not display the event which has the 

17th modification information.  This is the limit 

number of simultaneous expression 16. 
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3．Isn't the Static Memory Indicator displayed in red near the incorrect point?   

It may exceed the memory restriction. 

When the Static Memory Indicator is too high, adjust the total number of events or the size of each 

event to reduce the memory load. 

 

There are also several particular cases.  

* Although the Static Memory Indicator is barely exceeding the limitation, its memory restriction may 

be exceeded depending on the differences of the font size. 

For example; 

Although when the indicator shows barely exceeding in SCAS, 
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When the font size setting of the event setup dialog is 12 and the terminal font size setting is 16, 

some events may not be displayed because the memory is exceeding the limit on the terminal. 

Text Event Setup dialog Font Size in Terminal Information 

 
 

 

Therefore, set up the font size in the Event Setup dialog according to the terminal font size, so that 

the memory would not exceed the memory indicator limit when creating SMAF. 

 

 

4．Isn't the Image Development Load indicator displayed in red near the incorrect point? 

It may exceed the image development load capability. 

When the Image Development Load Indicator indicates a high value, make the image events smaller 

or adjust other events nearby. 
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1.9. Generating a SMAF file 
 

1.9.1. Can not generate a SMAF file! 
 

[Cause] 

Two causes can be considered. 

1. If the number of the simultaneous Banner copy exceeds 15, please refer to [Response 1]. 

 

 

2. If the total number of registered images and bitmaps exceeds 50 or 128 respectively, please refer 

to [Response 2]. 

 

 

 

[Response 1] 

Refer to the contents of the message: reduce the number of banner copies at the point of time. 

For more details about the number of the banner copy, please refer to” Chapter 2 ----- 6 Supplement 
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for Display Effect”.  

* If the setting a banner with a larger "Window Size" into the Event which a vertical size and a 

horizontal size are too small, the number of the banner copy increases. 

 

Use events which a vertical size and a horizontal size are large enough for the banner.  

 

For example, if the following message was displayed;   

 

 

 

 

 

 

 

 

 

 

 

The bold and underlined messages are indicating the parts which exceed the limit of the number of 

the banner copy. 

In this example, two parts are exceeding the limit of the number of the banner copy. 

The first part "T: 3000(4.1s) Copy: 18 (1 2 3) " indicates the situation that 18 banner copies exist in 

4.1sec from 3000msec point. 

The second part "T: 11800(2.7s) Copy: 17 (1 4 5) " indicates the situation that 17 banner copies exist 

in 2.7sec from 11800msec point. 

 

[Response 2] 

The number of the images and bitmaps used in SMAF has the restriction.  No data is available to play.  

In the cases of MA-5 and MA-3, each restriction becomes 50.  In the case of MA-7, the restriction 

becomes 128. 

 

- Overwork contents check. 
 
=====< current >===== 
[ 1] Time:0 Event:Rect Win:120 Obj:20(20) Copy:6 
[ 2] Time:1100 Event:Rect Win:120 Obj:20(20) Copy:6 
[ 3] Time:3000 Event:Rect Win:120 Obj:20(20) Copy:6 
[ 4] Time:10200 Event:Rect Win:120 Obj:20(20) Copy:6 
[ 5] Time:11800 Event:Rect Win:100 Obj:20(20) Copy:5 
 
T:3000 ( 4.1s) Copy:18 ( 1 2 3 ) 
T:11800 ( 2.7s) Copy:17 ( 1 4 5 ) 
 
[Total] Banner: 2counts  
[WarningTime / TotalTime] 6.8s / 17.2s 
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Example: 

As shown in the below figure, if the data is performed by MA-3 and the number of image and bitmaps 

are 51, SMAF cannot be output. 

 

 

 

2. Transferring 
 

2.1. Methods of transferring the data to a mobile phone 
There are roughly three kinds of methods to transfer SMAF onto a mobile phone as follows; 

- Transfer the data by “attach a file” in the e-mail.  

- Upload the SMAF file onto the web-site, and then download it with a mobile phone. 

- Transfer the file from PC through the external memory to a mobile phone. 

 

2.2. Can not transfer the data to a mobile phone! 
 

[Phenomenon] 

Can not transfer the SMAF file to a mobile phone. 

 

[Cause] 

Two causes can be considered. 

First, it may have occurred because of the defect or restriction of the communication infrastructure or 

memory device when transferring through them.  Second, it may have occurred when the SMAF file 

is too big to receive with a mobile phone. 

 

[Response] 

As a test, transfer a smaller size of the SMAF file.  
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If it works, the file size may be too big.  Adjust the SMAF data to make its size smaller. (Are you using 

a larger image file?) 

If a smaller size of the SMAF file could not be transferred either, a problem may exist in the 

communication infrastructure or the memory device itself.  Refer to the manual for the mobile phone, 

or ask your Carrier Support Center. 

 

 

3. View 
 

3.1. Can not replay the data on a mobile phone! 
 

[Phenomenon] 

Although the data was replayed on the emulator, it can not on a mobile phone. 

 

[Cause] 

- Setting error while creating a CAS file. 

- Applicable Carrier of the contents is incorrect. 

- Applicable Terminal (MA-2, MA-3, or MA-5) is incorrect.  

- The individual restriction of the mobile terminal 

 

[Response] 

The following methods are shown below; 

 

1. Prepare for the SCAS and CAS file which have been used for creating SMAF. 

2. Check an applicable country and a Carrier in the "About SCAS" dialog.  If it is incorrect, please 

download the correct SCAS from the SMAF Global Site. 
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3．Check an applicable terminal for generating SMAF.  If you are not really sure, select MA-3. 

 

 

4．There may be some individual restrictions of a Carrier or Maker.  Refer to the manual of a mobile 

phone, or ask the Carrier support center.  For more details, refer to “1.3 Restrictions”. 

 

 

3.2. Some events can not be displayed on mobile phone! 
 

[Phenomenon] 

Although some events were displayed on the emulator, they can not on mobile phone. 

 

[Cause]  

- Setting error while creating a CAS file. 

- Setting error of the contents information dialog.  

- Setting error of the terminal information dialog.  

- Individual restrictions of the mobile terminal (such as a size of the image, etc.) 

 

[Response] 

The following methods are shown below; 

1. Prepare for the SCAS and CAS file which have been used for creating SMAF. 

2. Check the settings in the Contents Information dialog and the Terminal Information dialog. 

3. Replay the data again on the emulator, and check whether the display is correct.  

If not, refer to “1.8.3 Some events are not displayed during " and edit it.  

4. Generate SMAF again, and then play it on a mobile phone. 

 

If a problem cannot be fixed, and the display is still incorrect, there may be an individual restriction of 

the terminal.  Especially for images, each terminal may have own restrictions (such as the size). 
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Adjust the images to make it larger or smaller.  Or delete the unnecessary information (such as 

α-channel).  

 

 

3.3. The location is misarranged when replaying on a mobile phone! 
 

[Phenomenon] 

The location is misarranged when playing on a mobile phone. 

 

 

 

 

 

 

 

[Cause] 

A display may be misarranged when "Rendering size" or "Font size" which is set up by SCAS is 

different from "Display area" or "Font size" of the terminal. 

 

[Response] 

The following methods are shown below; 

 

1. Prepare for the SCAS and CAS files which have been used for creating SMAF. 

 

2. In SCAS, select [Edit]  [Content Info...] from the menu to open the [Contents Information] dialog. 

Then, set up "Rendering Size" and "File output RS tag" with its "Width" as 120 and "Height" as 130. 

(If “Origin Move” is set up, also enter 120 and 130 into the value.  For more details of Origin Move, 

refer to “Chapter 5 ----- 5.6.3 Origin Designation”.)  

 

* Depending on a type of mobile phones, the effective display area may not be 120 dots x 130 dots. 

In this case, correct the misarrangement of the display location adjusting rendering size. 
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3. Check the disarrangement of the display location in the Page Edit Window, and then correct any 

errors.  

 

 

4．A font size may differ depending on the type of mobile phones.  Adjust the contents without 

changing its appearance too obvious even if a font size differs in 1 or 2 dots. 

 

 

3.3.1. Contents are not smoothly displayed on a mobile phone! 
 

[Phenomenon] 

Contents are not smoothly displayed on a mobile phone. 

 

[Cause] 

Since the screen refresh rate of a mobile phone is around 200 to 300, 3 to 5 frames are displayed in 

one second.  Therefore, sometimes the display may not be smooth. 

 

[Response] 

Create SMAF with considering the screen refresh rate. 

When creating contents which have fine motions, adjust it by actually displaying the contents on a 

mobile phone. 

 

 

3.3.2. Blinking effect is not working correctly when replaying on a mobile phone! 
 

[Phenomenon] 

When playing on a mobile phone, it may not blink or may blink irregularly. 

 

[Cause] 

When blinking time of SMAF and the refresh rate of a mobile phone do not match, blinking may 
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become irregularly. 

 

[Response] 

The screen refresh rate of a mobile phone is 200 to 300 msec. Therefore, designate a longer margin 

between the blinking intervals. 

Adjust it until blinking on a mobile phone becomes regularly. 
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Chapter 9 -----  Samples 
 
This section prepares for the links of the sample data created by SCAS: SCAS can be easily started 

through the links.  

At first, open the Emulator Window and play the data.  Observe the differences between each 

displayed object.  Then, you can find the setup property by opening the Setup Dialog of each event. 

Use this link as a sample to understand how each property works. 

 
1. Sample of Wipe Effect 

 

File wipe1.cas 

Description Wipe Effect is designated to the text.  The Backdrop color is set as dark blue in the 

[Backdrop Color] dialog.  

With the text line on the top, as default, the Text color is set as black whereas the Text 

background color is set as white.  And then, it changes the Text color after wipe into 

red, and the Text background color after wipe into white.  When the Text background 

color and the Backdrop color differ, a frame like this sample can be seen. 

With the text lines in the middle, the Text background color is set as yellow.  

Furthermore, yellow is defined as a transparent color.  Therefore, a dark blue color 

as a Page Backdrop color can be seen.  The Text background color after wipe is set 

as the same color as the Backdrop color, so that the text frame can not be seen. 

With the text lines at the bottom, the Text color before and after wipe are both set as 

white.  For the Text background color, it is set as the same color as the Backdrop 

color before wipe, but it designates the different color after wipe. 

 

2. Sample of Wipe Sequence Effect 
 

File swipe.cas 

Description Wipe Sequence Effect is designated to the text block.  The Backdrop color is set as 

dark blue.  

The first text block consists of three lines.  The layout of the first line is left aligned, 

the second line is center aligned, and the third line is right aligned.  For the color 

setting, it sets the Text color as black, Text background color as white, Text color after 

wipe as red, and Text background color after wipe as yellow.  Although the Block 

background color is set as green, the color is not indicated because the “Transparent” 

color is also set as green.  Wipe sequence starts one second after the Event display, 

and change the color of the text from the beginning. 

All three lines are aligned into the center in the next text block.  
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Three lines in the next text block are all center aligned, and a line space exists.  For a 

color setting, it sets the Text color as black, the Text background color as white, the 

Text color after wipe is yellow, and the Text background color as black.  Since the 

Transparent color is designated as black, the Text color and Text background color 

after wipe can not be indicated.  A Line space is indicated in green because the Block 

background color is green.  Wipe sequence starts as Event is displayed.  Since the 

Designate number of characters to be wiped is set to "40", the last two characters are 

not be wiped. 

 

3. Sample of Banner Effect 
 

File banner1.cas 

Description The first text performs a banner for 10 seconds in 15 seconds life time.  It moves for 

the length of the text data, i.e. one-banner length.  The End position is controlled by 

a banner transfer distance and banner time. 

The second text displays a banner twice in the negative direction.  When displaying it 

more than twice, it is necessary to turn-back to the direction as same as the banner 

direction.  The end position is controlled by a banner transfer distance and a banner 

time. 

The third text designates a banner in the vertical direction.  It performs a banner 

three times in the positive direction.  The end position is controlled by a banner 

transfer direction and a banner time. 

The fourth text designates a banner in the vertical direction.  It performs a banner 

during the life time in the negative direction.  It can be set by making a transfer 

distance to be "0".  A banner transfer speed can be changed by changing a transfer 

time.  

The fourth text designates a banner in the vertical direction.  It performs a banner 

during the life time in the negative direction.  It can be set by setting a transfer 

distance to be 0.  A banner transfer speed can be changed by changing a transfer 

time.  When a transfer distance is 0, a transfer speed is converted into a transfer 

time per 100dots. 

 

4. Sample of Blink Effect 
 

File blink.cas 

Description Blinking effect is designated to the test.  In order to designate the count of blinking, 

the number of times of the status changes, such as [appear] to [disappear] or 

[disappear] to [appear], are specified.  Enter 2 in order to disappear once and to 

appear once. 
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The above text appears for 3 seconds, and then disappears for 2 seconds.  Since Life 

Time is designated as 10 seconds, it ends for the left 5 seconds, disappearing. 

The center text blinks 2 cycles since designation of Blinking count is four times.  

The text at the bottom is set its Blinking count as 0.  Designation of 0 is interrupted 

as the repeating of blinking.  In addition, it matches the Text background color and 

the Backdrop color so that the frame can not be seen. 

 

5. Sample of Color Blink Effect 
 

File colorblink1.cas 

Description Color Blinking Effect is designated to the text.  In order to designate the count of 

color blinking, the number of times of status changes, such as [normal color] to [wipe 

color] or [wipe color] to [normal color], are specified.  Enter 2 in order to wipe the 

color once and to return to the normal color.  In order to designate color blinking, set 

a normal Text color at Text tab, the Text color after wipe at Wipe tab, and period and 

Blink count at Color Blink tab.  

The above texts indicate a normal color for 3 seconds, and then wipe it for 3 seconds. 

Since Life Time is designated as 10 seconds, it ends for the left 4 seconds, wiping. 

The center text reversal-blinks 2 cycles since designation of Blinking count are four 

times. 

The text at the bottom is set its Blinking count as 0.  Designation of 0 is interrupted 

as the repeating of reversal-blinking. 

 

5.1. Sample of Fade Effect 
 

File fade1.cas 

Description Fade effect is designated to the text and the image.  First ABCDE is a simplest 

example. 

The next image appears from the left top corner by the designation of Left Top Corner 

In, and then disappears in the right bottom corner by the designation of Right Bottom 

Corner Out.  Set each Fade type and Fade time.  The Description text disappears 

normally because only Fade-in is set and Fade-out is not. 

 

5.2. Sample of Move Effect 
 

File travel1.cas 

Description Moving effect is designated to the text. 

When designating Move sequence time as 0, an object moves momentarily from a 

former place. 
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But when 0 continues, it becomes un-stabilized, and may be ignored or may not be 

indicated. 

After moving an object momentarily using 0, make sure to designate an actual time so 

that the graphic object can be continuously displayed. 

If designating multiple times on the same coordinate, the designated time is also 

assumed as stopping. 

 

6. Complex Effect 
 

It is possible to designate multiple effects into one graphic object, though a sample is not prepared. 

An object can be seen in various ways by operating the complex effect and multiple objects into one 

object.  Please try out many patterns. 

 

7. Layout Sample 
 

File layout.cas 

Description Sample contents are created as a reference for the SCAS coordinate definition.  The 

contents show the difference of operations that occurs when the screen size and 

methods of designating coordinate system are defined by three types of the 

coordinate system- standard coordinate system, symmetrical coordinate system, and 

layout coordinate system. 

Register two kinds of terminals, which the effective display area is 96x104 and 

120x117, then start multiple emulators. 

 

8. Origin Designation Effect Sample 
 

File layout.cas 

Description Sample contents properly display the data, which is for small LCD, on a larger LCD by 

using origin move. 

With the standard coordinate system and the symmetrical coordinate system, the 

position of the rectangle set by Origin designation can be maintained regardless of the 

LCD size.  

Multiple LCD screen information’s can be registered at the “Display Size” tab in the 

Terminal Information dialog. 

Operation is carried out by using the terminal information of the larger screen. 

Input the smallest size of a terminal screen which is to be created as a general 

purpose at the Origin Designation tab. 

An rectangle of the input screen size will be displayed on the Page Edit Window. 
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